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1 Introduction 

This document describes OpenText Connectivity 15 Service Packs, including new features, resolved 

issues, and known issues. OpenText recommends that you read this document in conjunction with the 

documentation included with the software package. If any conflicts exist, this document supersedes 

the other documentation. 

1.1 Release Notes Revision History 

Revision Date Sections Revised Description of Revisions 

2019-25-09 SP7 release Service Pack 7 content 

2018-12-10 SP6 release Service Pack 6 content 

2018-02-09 SP5 release Service Pack 5 content 

2017-10-17 SP4 release Added CONN-3275 

2017-08-21 SP4 release   Service Pack 4 content 

2017-04-25 SP3 release (Issues resolved) Added CONN-3019 

2017-04-14 SP3 release Service Pack 3 content 

2016-03-31 SP2 release Service Pack 2 content 

2015-08-28 SP 1 release Service Pack 1 content 

2 Packaging and documentation 

Software downloads and documentation for OpenText Connectivity products are available on the 

OpenText My Support (https://support.opentext.com/). 

2.1 Related documentation  

The following guides provide additional information about the Version 15 products. The guides can be 

downloaded from OpenText My Support (https://support.opentext.com/). 

https://support.opentext.com/
https://support.opentext.com/


 

OpenText Connectivity Version 15 Service Pack Notes  

7 

• OpenText Connectivity Installation Guide 

• OpenText Connectivity Migration Wizard Guide  

• OpenText Connectivity Web-to-Host and Deployment Wizard Guide 

• OpenText Exceed User's Guide 

• OpenText HostExplorer User's Guide 

• OpenText HostExplorer Programmer's Guide 

• OpenText HostExplorer Basic Language Programmer's Guide 

• OpenText Secure Shell User's Guide 

• OpenText Connectivity Release Notes 

3 Installation instructions 

This section describes how to install an OpenText Connectivity Service Pack, or a hot fix.  

Note:  File names supplied in the installation procedures are example file names only. 

Replace them with the name of the files you downloaded. 

3.1 Installing  FIPS Only version of Connectivity  15.0.1   

This section describes how to install FIPS Only version of OpenText Connectivity 15.0.1. 

 

Note: These instructions apply if you do not already have FIPS Only version of Connectivity 15.0.1 or 

higher installed.  If you have already followed these instructions then you do not need to uninstall, as 

upgrading to a new version will keep things in the correct FIPS Only state. 

To install FIPS Only version of OpenText Connectivity: 

1. Uninstall the previous version of OpenText Connectivity. 

2. Visit OpenText Knowledge Center (https://knowledge.opentext.com/).  

3. Locate the OpenText Connectivity page for downloads, and the OpenText Connectivity 

installation packages.   

4. Download the installation package/file for the product you want to install. Both the 32 and 64-

bit versions are available. You can download:  

▪ a DVD ESD self-extracting executable file which will expand the DVD contents 

(including msetup.exe) to a folder on your computer 

▪ a product ISO file which can be mounted or burned to physical DVD media. For 

example, OpenTextExceed15.0.1.iso  

5. Once you have access to the DVD folder tree, run the msetup.exe to continue the 

installation process.  

6. Follow the on-screen prompts, to complete the installation.   

 

 Note: For details on FIPS Only installation, see FIPS compliance update on page 88.  

https://knowledge.opentext.com/
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3.2 Installing the EXE format  

This section describes how to install Connectivity 15.0.1 using the .exe format. Use this 

procedure if you do not want to limit yourself to using FIPS only version of OpenText Connectivity.  

1. Unzip the service pack and run the self-extracting executable as per your platform/product: 

OpenTextConnectivity15_ServicePack1.exe or 

OpenTextConnectivity15x64_ServicePack1.exe  

2. The OpenText Installation Wizard will guide you through the installation.  

3. Select the Service Pack Installation Method. You can install the service pack onto a locally 

installed product or onto an administrative image. 

4. Click Next to install the service pack.  

 Note: If you want to view the service packs available and their corresponding version 

numbers, please enable the following check box: 

Disable automatic patch selection (you select the patches to 

install). 

Click Next, and then click Patch Details, for the selected service pack. 

3.3 Installing the MSP format 

This section describes how to install a using the .MSP format. Use this procedure if you do not want 

to limit yourself to using FIPS only version of OpenText Connectivity.  

• Apply the appropriate .MSP file needs to each of the OpenText products that you have 

installed. You need to apply multiple MSP files if you have multiple products, i.e., Exceed 

and OpenText Secure Shell. The MSP service pack can be applied to one or the other of 

the listed options. 

 Note: A reboot may be required after the service pack installation. 

Apply to… Details 

a) Personal 

installation 

— OR 

Right click on the MSP service pack and choose Apply OR from a command 

line execute: msiexec /p < MSP_file>  
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Apply to… Details 

b) An unpatched 

Administrative 

image or a patched 

Administrative 

image 

From a command line, execute: msiexec /a /p < MSP_file> 

Example:  

C:\>msiexec /a 

"C:\Exceed15_Admin\OpenTextExceed_ServicePack1.msi" /p  

"C:\Exceed15_Admin\ OpenTextExceed15x64_ServicePack1.msp” 

 

 

3.4 Hot fix installation instructions 

This section describes how to install the hot fixes. Hot fixes address software issues, and typically do 

not contain new functionality. Hot fixes can be cumulative.  

• Note: The file names in the following procedures are examples only. Replace them 

with the name of the files you downloaded. 

1. Unzip the downloaded hot fix file: 

2015-06-15_exceed.exe_v15.0.1.745  

2. Replace the contents of the existing Exceed directory with the contents supplied in the 2015-

06-15_exceed.exe_v15.0.1.745 hot fix directory. 
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4 Connectivity 15.0.7 (Service Pack 7) 

This section lists the new features, resolved issues, and known issues of OpenText Connectivity, 

Version 15.0.7, also known as Version 15.0, Service Pack 7.   

4.1 New features in Connectivity 15.0.7 

This section lists the new features and enhancements implemented in Connectivity 15.0.7 (Service 

Pack 7).  For descriptions of the feature added via hot fixes, see New features in Connectivity 15.0.6 

hot fixes.  

4.1.1 XDK compatible with Visual Studio 2015+ 

Modified the Motif12 and Motif20 code to build the 32-bit Xmstatic.lib compatible with Visual 

Studio 15 and later versions.  

JIRA ID: CONN-3860 

4.1.2 HostExplorer new function for toggling the selection mode 

The following function was added to the HostExplorer Keyboard Map utility, under Function group > 

Editing Keys:  

• Toggle-Edit-Selection-Mode—Toggles the text selection mode between BLOCK text selection 

and STREAM text selection.  

JIRA ID: CONN-3921 

4.1.3 Support for Windows Server 2019 

Added support for Windows Server 2019 to all OpenText Connectivity products. 

Note: OpenText Connectivity Web-to-Host and Deployment Wizard was updated to Service Pack 8 

(SP8), to support running it on Windows Server 2019. 

JIRA ID: CONN-3979 

4.1.4 New OpenSSL Version 

OpenSSL libraries have been updated to Version 1.0.2r.   

For more information about the OpenSSL versions, refer to the OpenSSL Release Notes: 

https://www.openssl.org/news/openssl-1.0.2-notes.html 

https://www.openssl.org/news/openssl-1.0.2-notes.html
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4.2 New features in Connectivity 15.0.6 hot fixes 

The following new features were added via hot fixes, after the release of Connectivity 15.0.6, and 

prior to completion of Connectivity 15.0.7 release. All the hot fixes are cumulative and included in the 

15.0.7 release. 

4.2.1 New feature in Hot Fix 8 

This section describes the new feature added in Hot Fix 8. 

JIRA ID Description Affects  

CONN-3858 Added the ability of HostExplorer to automatically detect 

the SSL/TLS user certificate and attempt to connect 

using this certificate.  

New configuration option 

The following option was added to the User 

Authentication > User Certificate mode section:   

• Automatically select smart card certificate 

When this option is selected: 

• If a smart card certificate is found, a connection 

is established through the certificate 

• If no smart card certificate is found, the 

connection fails and the following message is 

displayed:   

No smart card certificate found  

HostExplorer   

4.2.2 New feature in Hot Fix 2 

This section describes the new feature added in Hot Fix 2. 
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JIRA ID Description Affected 

Component(s) 

CONN-3885 Connectivity Secure Shell now supports the following 

Elliptic Curve Digital Signature Algorithm (ECDSA): 

ecdsa-sha2-nistp256 

The user needs to have the following files:   

CKStore.dll 

Humtunnel.dll 

HumCSSPlugins.dll 

libeay32.dll 

libeay32f.dll 

ssleay32.dll 

ssleay32f.dll 

OpenText 

Connectivity Secure 

Shell 

4.2.3 New feature in Hot Fix 1 

This section describes the new feature added in Hot Fix 1. 

JIRA ID Description Affected 

Component(s) 

CONN-3858 Added the ability of HostExplorer to automatically detect 

the SSL/TLS user certificate and attempt to connect 

using this certificate. Updated the heui32.*.nls 

component.  

New configuration option 

The following option was added to the User 

Authentication > User Certificate mode section:   

• Automatically select smart card certificate 

When this option is selected: 

• If a smart card certificate is found, a connection 

is established through the certificate 

HostExplorer   
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JIRA ID Description Affected 

Component(s) 

• If no smart card certificate is found, the 

connection fails and the following message is 

displayed:   

No smart card certificate found  

 

4.3 Issues resolved in Connectivity 15.0.7  

JIRA ID Description Affected 

Component(s) 

CONN-3993 The Nautilus application appears to re-launch itself 

consistently when the following two conditions are met:  

• Working in Gnome (or left idle)  

-and- 

• Multiple Exceed instances are running.  

The Gnome sessions are launched by Xstart in Secure 

Shell startup mode.  

OpenText 

Connectivity Secure 

Shell 

Xstart 

CONN-3986 Resolved the following issue: 

• When an Xapplication is launched, the image 

flashes and disappears.  

The fix ensures that the Exposure events  caused by 

ClearArea are not suppressed by BackingStores. I.e., the 

server will send an expose if anything was painted by 

ClearArea. 

OpenText 

Connectivity Exceed 

CONN-3953 Removed the GTK libraries, due to licensing restrictions. OpenText Exceed 

XDK 

CONN-3942 Resolved the following issue: 

• The Auto-Close option did not work consistently. 

Initially, Xconfig was closed successfully at the set 

OpenText 

Connectivity Exceed 
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JIRA ID Description Affected 

Component(s) 

time, but after a while, the option no longer took 

effect and the application was not closed 

automatically.  

 

The issue was detected with the following 

configuration:  

Xconfig > Communication > Passive > 

Auto-Close connection after 1 

minutes > Close even when 

application is active. 

CONN-3912 Updated the Kerberos executables to latest retail 

versions. 

OpenText 

Connectivity 

CONN-3887 Resolved issue where the admin package was missing 

the MSP file, causing the installation to fail with the 

following error message: “This patch package could not 

be opened”. 

HostExplorer 

CONN-3850 Resolved the following issue:  

• The user cannot connect to HMC CR9 AS/400 

system console via a 5250 profile 

New profile option 

Added the following new option for TN5250E profile:  

TN5250E Send Terminal Type Before New 

Environ"=Off ( default) 

Note: To address the above issue, if you are using HMC 

C9 server ( or any mainframe using "extended telnet"), 

update the profile as follows:  

• Enable the profile option, in the [PROFILE] section of 

the .hep file. That is, set the option as follows:  

OpenText 

Connectivity 

HostExplorer 
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JIRA ID Description Affected 

Component(s) 

TN5250E Send Terminal Type Before 

New Environ=On  

 

4.4 Issues resolved in Connectivity 15.0.6 hot fixes 

The following issues were resolved in hot fixes after the release of Connectivity 15.0.6, and prior to 

completion of Connectivity 15.0.7 release. All the hot fixes are cumulative and included in the 15.0.7 

release.  

4.4.1 Issue resolved in Hot Fix 11 

This section describes the issue resolved in this hot fix.  

JIRA ID Description Affected 

Component(s) 

CONN-3976 Resolved an issue that caused the title bar to disappear. 

Fixed unmapping /mapping in rapid succession without 

Delay Window Mapping.  

OpenText 

Connectivity Exceed 

4.4.2 Issue resolved in Hot Fix 9 

This section describes the issue resolved in this hot fix.  

JIRA ID Description Affected 

Component(s) 

CONN-3969 Resolved the following issue: 

• Exceed did not draw PolyPoint correctly when 

the CoordMode was Previous. As a result, pages 

displayed with an X application appeared 

truncated.  

OpenText 

Connectivity Exceed 



 

OpenText Connectivity Version 15 Service Pack Notes  

16 

JIRA ID Description Affected 

Component(s) 

CONN-3961 Resolved the following issue, which occurred 

intermittently:  

• An xterm window was expanded, and then 

stopped responding to mouse actions. The fix 

removed the moving/sizing deadlock on 

Windows 10. 

OpenText 

Connectivity Exceed 

4.4.3 Issue resolved in Hot Fix 7 

This section describes the issue resolved in this hot fix.  

JIRA ID Description Affected 

Component(s) 

CONN-3937 • Resolved a crash issue that could occur when 

window manipulations happened in rapid succession 

in Multiple Window Mode. 

OpenText 

Connectivity Exceed 

4.4.4 Issues resolved in Hot Fix 6 

This section describes the issue resolved in Hot Fix 6. 

JIRA ID Description Affected 

Component(s) 

CONN-3876 

CONN-3370 

CONN-2949 

Resolved an issue where explorer.exe failed to be 

launched after Windows 10 patches were applied, or 

during a Windows 7 to Windows 10 upgrade. Exceed, 

HostExplorer and OpenText Secure Shell make use of 

Microsoft Active Setup to push Per-User settings when 

users log in.  

In the above situations (e.g., during Windows 10 

upgrades) these keys were removed. After reboot and 

login, Explorer attempted to launch Connection Central, 

but the installer was blocked. All the desktop icons, 

Active Setup 

 

 

  



 

OpenText Connectivity Version 15 Service Pack Notes  

17 

JIRA ID Description Affected 

Component(s) 

including the Connection Central, were missing and the 

Windows 10 desktop remained blank.  

The issue is no longer present. Explorer is no longer 

blocked from starting.  

4.4.5 Issues resolved in Hot Fix 5 

This section describes the issue resolved and the OpenSSL update added in Hot Fix 5. 

JIRA ID Description Affected 

Component(s) 

CONN-3939 Resolved an issue causing HostExplorer to crash. The fix 

contains the following updated files:   

ckstore.dll 

humcssplugins.dll 

humtunnel.dll 

hetptn.dll 

libeay32.dll 

libeay32f.dll 

ssleay32.dll 

ssleay32f.dll 

OpenText 

HostExplorer 

  

4.4.6 Issue resolved in Hot Fix 3 

This section describes the issue resolved in this hot fix.  

JIRA ID Description Affected 

Component(s) 

CONN-3798 Resolved the following issue:  

• Expose events were not properly delivered to 

Windows using Direct GLX rendering. 

OpenText 

Connectivity Exceed 
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5 Connectivity 15.0.6 (Service Pack 6) 

This section lists the new features, resolved issues, and known issues of OpenText Connectivity, 

Version 15.0.6, also known as Version 15.0, Service Pack 6.   

5.1 New features in Connectivity 15.0.6 

This section lists the new features and enhancements implemented in Connectivity 15.0.6 (Service 

Pack 6).  For descriptions of the feature added via hot fixes, see New features in Connectivity 15.0.5 

hot fixes.  

5.1.1 Support for more rows and columns in HostExplorer 3270 profiles 

HostExplorer 3270 profiles may now include a greater number of columns and rows. The maximum 

number of rows and columns has increased, from 72 to 155 rows, and from 200 to 255 columns.    

To configure the number of rows and columns: 

1. Open the property editor for a 3270 profile and select the Terminal > 3270 tab.  

2. Change the 3270 Model value to Custom, and then then change the Rows and Columns 

settings as follows:  

▪ Rows (20 To 125) — Enter any number between 20 and 125; this defines the number of rows 

on the screen for your next session    

▪ Columns (80 To 255) — Enter any number between 80 and 255; this defines the number of 

columns for the next session.   

JIRA ID: CONN-3781 

5.1.2 HostExplorer shortcuts for toggling between upper and lower case 

New keyboard shortcuts for toggling between upper and lower case have been added to the 

Keyboard Map dialog. These shortcuts change the case of the character at the cursor location to 

either upper or lower case. The cursor is then moved one character to the right, which allows 

repeated use of the shortcut to capitalize entire words or fields.    

The following new functions were added to the Keyboard Map utility, under Function group >   

Editing Keys:  

• Cursor-Make-Uppercase—Toggles the character at the current cursor position to upper case, 

and then moves the cursor to the next position.  
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• Cursor-Make-Lowercase—Toggles the character at the current cursor to lower case, and then 

moves the cursor to the next position. 

Note: If the character at the cursor location is already in the target case (upper or lower), the cursor 

moves to the right without changing the character in that position. 

  

JIRA ID: CONN-3831 

5.1.3 New OpenSSL Version 

OpenSSL libraries have been updated to Version 1.0.2p.   

For more information about the OpenSSL versions, refer to the OpenSSL Release Notes: 

https://www.openssl.org/news/openssl-1.0.2-notes.html 

JIRA ID: CONN-3886 

https://www.openssl.org/news/openssl-1.0.2-notes.html
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5.2 New features in Connectivity 15.0.5 hot fixes 

The following new features were added via hot fixes, after the release of Connectivity 15.0.5, and 

prior to completion of Connectivity 15.0.6 release. All the hot fixes are cumulative and included in the 

15.0.6 release. 

5.2.1 New feature in Hot Fix 27 

The following feature was added in this hot fix. 

JID Description Affects   

CONN-3880 Added support for XVideo on multiple monitors even when the X 

application asks to use one video device only (one monitor). 

 Exceed 

5.2.2 New feature in Hot Fix 24 

The following new feature was added in this hot fix. 

JID Description Affects   

CONN-3723 HTTP Proxy support in HostExplorer FTP 

HostExplorer FTP now supports secure connections through an 

intermediate HTTP proxy.  

To enable HTTP proxy support:  

1. Go to the FTP Site Properties dialog box.  

2. At the Firewall/Proxy tab, under Firewall Type, select HTTP 

Proxy. 

 

 HostExplorer 
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5.2.3 New feature in Hot Fix 22 

The following new feature was added in this hot fix. 

JID Description Affects   

CONN-3858 HostExplorer can now cache the SSL/TLS user certificate, and 

then reuse it for future connections. This user certificate is 

selected during the initial connection, when the user is presented 

with a prompt to select a user certificate. The feature applies to 

3270, 5250, and VT connections.  

New configuration option 

The following option was added to the User Authentication > 

User Certificate mode section:   

• Remember for future connections 

Workflow  

1. Under User Authentication > User Certificate mode, select 

the option Remember for future connections. 

2. Select the user certificate during the initial connection, when 

prompted to do so.  

 

The certificate will be cashed and used for future connections 

(the prompt to select a user certificate will no longer be 

displayed). If the option Remember for future connections 

is disabled, the prompt to select a user certificate will be 

displayed as before. 

HostExplorer   

 

5.2.4 New feature in Hot Fix 12 

This section describes the new feature added in Hot Fix 12. 

JID Description Affects   

CONN-3741 Updated screen resizing in HostExplorer   

When a HostExplorer 3270 session connects to the mainframe, 

the screen size used is 24x80. The user can submit jobs on one 

HostExplorer   
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JID Description Affects   

of the available screens. Once a job is submitted from that 

screen, the HostExplorer screen is no longer resized to 43x80 to 

show unpopulated rows.  

 

5.3 Issues resolved in Connectivity 15.0.6  

JIRA ID Description Affects 

CONN-3876 

CONN-3370 

CONN-2949 

Fixed an issue where explorer.exe would fail to launch after 

Windows 10 patches were applied.  

Exceed, HostExplorer and OpenText Secure Shell  make use of 

Microsoft Active Setup to push Per-User settings when users log 

in. During Windows 10 upgrades these keys were removed. After 

reboot and login, Explorer attempted to launch Connection 

Central, but the installer was blocked.  All the desktop icons, 

including the Connection Central, were missing and the Windows 

10 desktop remains blank. Explorer is no longer blocked from 

starting in this situation.  An automatic repair will take place when 

the User Files shortcut is launched. 

Install/Migration 

CONN-3867 Resolved a HostExplorer crash, which occurred when a user 

attempted to copy a string that contained more than 2080 

characters and the following settings were selected:  

1. Go to Session Profile > Edit category > Cut/Copy page > 

Auto copy selected text. 

2. Select Edit > Clipboard > Cell delimited > Separate at 

word. 

Attempting to copy a string longer than 2080 characters, when the 

above settings were in effect, resulted in a crash. To avoid this 

issue, and buffer overruns, HostExplorer now uses dynamic 

memory allocation, instead of fixed array size of 2048.  

HostExplorer 

CONN-3769 Resolved an issue that caused the hclintr.dll to crash over a 

VPN connection.  

Exceed 
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JIRA ID Description Affects 

CONN-3672 Reverted a change made in version 11.5.4 (SP4) where the Shift 

and Caps Lock Actions were added to the Keyboard Mapping 

dialog.  This change ensures that the Caps Lock and Shift key 

states are always correct in the Operator Information area (OIA). 

HostExplorer 

CONN-3234 Resolved an issue affecting the setting: Hold Screen shortcuts. 

The issue was observed in the following context:  

• Under VT Session Properties > Keyboard > Advanced 

> Shortcuts, clear the check box Hold Screen shortcuts 

(Ctrl+S and Ctrl+Q). Despite the setting being disabled 

the Ctrl+S and Ctrl+Q shortcuts remain in effect.  

The issue has been resolved and the shortcuts will now be 

disabled correctly. 

HostExplorer 

 

5.4 Issues resolved in Connectivity 15.0.5 hot fixes 

The following issues were resolved in hot fixes after the release of Connectivity 15.0.5, and prior to 

completion of Connectivity 15.0.6 release. All the hot fixes are cumulative and included in the 15.0.6 

release.  

5.4.1 Issues resolved in Hot Fix 26 

The following issue was resolved in this hot fix. 

JID Description Affects   

CONN-3788 Resolved the issue that caused HostExplorer 3270 session 

to become unresponsive when the user chose the following 

configuration:  

• Terminal > 3270 > 3270 model: custom model: (24x100)  

This fix was partially completed in HF 16. This fix addresses 

hepar3270.dll.       

 HostExplorer 
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5.4.2 Issues resolved in Hot Fix 25 

The following issue was resolved in this hot fix. 

JID Description Affects   

CONN-3875 An FTP profile could not be created in Connection Central. 

Instead, the following error was displayed: 

Profile\ftp.test.test.hfs 

The system cannot find the path specified. 

The issue has been resolved, and the path is now detected 

successfully.  

Host Explorer 

5.4.3 Issues resolved in Hot Fix 23 

The following issue was resolved in Hot Fix 23 

JID Description Affects   

CONN-3788 Resolved the issue that caused HostExplorer 3270 session 

to become unresponsive when the user chose the following 

configuration:  

• Terminal > 3270 > 3270 Custom model: (24x100) 

This fix was partially completed in HF 16. The new fix 

addresses hepar3270.dll.  

HostExplorer   

 

5.4.4 Issues resolved in Hot Fix 21 

The following issue was resolved in this hot fix. 

The following issue was resolved in this hot fix. 

JID Description Affects   

CONN-3839 Replaced all modal dialog calls in Xstart with direct Windows 

API calls (the product no longer uses the hclwutil.dll).  

 Exceed 
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JID Description Affects   

The fix further addresses the issue that may cause the 

Setting button in Xstart dialog not to work in a particular 

environment.   

 

5.4.5 Issues resolved in Hot Fix 20 

The following issue was resolved in this hot fix. 

JID Description Affects   

CONN-3839 Connectivity now provides more information about the issue 

that may cause the Setting button in Xstart dialog not to work 

in a particular environment.  The issue was detected on 

Windows 10, with Exceed SP 5 (x64) and Secure Shell SP5 

(x64). Also, when either Browse button was clicked the 

following error message was displayed:   

Display specified modal dialog box failed.   

 
HF20 adds information from the Windows getLastError() 

function when a modal dialog cannot be created. It is 

displayed as an additional line in the error message box. 

HF20 works identically for   the Settings button and both 

Browse buttons.  

 Exceed 
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5.4.6 Issues resolved in Hot Fix 19 

The following issue was resolved in this hot fix. 

JID Description Affects   

CONN-3759 Resolved the following issue, noticed under Windows 10:  

• Connection Central does not accurately show the number 

of items it contains, Instead, the number of items is 

reported as 0 (in the lower left hand corner of the 

window).   

 

HostExplorer   

 

5.4.7 Issues resolved in Hot Fix 18 

The following issue was resolved in this hot fix. 

JID Description Affects   

CONN-3834 Resolved the following issue:  HostExplorer   
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JID Description Affects   

• Unable to select text using the Shift + Cursor keys 

with Service Pack 5. 

5.4.8 Issues resolved in Hot Fix 17 

The following issue was resolved in this hot fix. 

JID Description Affects   

CONN-3812 Resolved some display issues when changing the number of 

columns. 

HostExplorer   

 

5.4.9 Issues resolved in Hot Fix 16 

The following issue was resolved in Hot Fix 16. 

 

JID Description Affects   

CONN-3788 Resolved the following issue:  

• HostExplorer 3270 session becomes unresponsive when 

the user chooses the following configuration:  

HostExplorer   
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JID Description Affects   

o Terminal > 3270 > 3270 model: Model 5 

(27x132). 

 

 

5.4.10 Issues resolved in Hot Fix 15 

The following issue was resolved in Hot Fix 15. 

JID Description Affects   

CONN-3808 Resolved usability issues observed when the HostExplorer 

Keyboard Mapping dialog box was used in conjunction with 

JAWS® For Windows (a computer screen reader for people 

who are blind and visually impaired).  

It is expected that when a key is clicked in the Key Mapping 

dialog box, it is announced audibly and correctly. Some keys 

on the keyboard map were not audible or announced 

correctly (for example, this was noticed with the numeric 

keypad keys, Function keys, as well as the Page up, Delete, 

or End Page keys). The issues were detected with various 

keyboard layouts. For example, these keyboard layouts were 

chosen:   

• Enhanced 105 keys 

• Dec LK 450 keyboard 

HostExplorer   
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JID Description Affects   

Example: When the user selects keys other than the typical 

keys (e.g., Shift), and then Home, Page up, Delete, or End 

Page keys, JAWS announced some graphics code. 

CONN-3779 Resolved other usability issues observed when the 

HostExplorer Keyboard Mapping dialog box was used in 

conjunction with JAWS® For Windows (a computer screen 

reader for people who are blind and visually impaired).  

Some of the keys on the keyboard map were not audible or 

announced correctly. The following issues were addressed:  

• Clicking on the function keys F1—F12, and all the 

numeric keypad keys, did not produce the expected 

sound (instead of announcing the key name, the screen 

reader mentioned some graphics code).   
• Clicking on some of the function keys (F1—F12), 

mapped to any other dialog, did not produce the sound 

with the mapped dialog name (no information related to 

the mapped dialog was announced; instead, some 

graphics code was mentioned).  

• Clicking on some keys did not produce a complete 

audible description (only the word “button” was 

announced, but it was not indicated which one). 

• Clicking on some keys produced an incorrect audible 

description. E.g., the Return key was interpreted as a 

numeric key. 

HostExplorer   

CONN-3776 Resolved a usability issue that affected how HostExplorer 

menus were shown when Windows 10 was switched to a 

High Contrast setting. Some menus became unreadable.  

The issue was observed in the following context:   

▪ Press ALT+SHIFT+PRINT to switch Windows 10 to a 

High Contrast setting. As a result, some menus become 

unreadable.  

 

▪ High Contrast Black—HostExplorer pull down 

menus are shown as white on white.  

HostExplorer   
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JID Description Affects   

▪ High Contrast 2— HostExplorer pull down 

menus are shown in light colors on white 

background, whereas the Global Functions are 

shown as partially black on a dark background.  

Example: 

 

5.4.11 Issues resolved in Hot Fix 14 

This section lists the issues initially resolved in Hot Fix 14. 

JID Description Affected 

Component(s) 

CONN-

3772 

Resolved an issue causing OpenGL windows using Direct 

Rendering to flicker or blank on XConfigureWindow(). 

Exceed   

5.4.12 Issues resolved in Hot Fix 13 

This section lists the issues initially resolved in Hot Fix 13. 

JID Description Affected 

Component(s) 

CONN-3749 Resolved the following Exceed XDK issue:  hclglx.dll   
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JID Description Affected 

Component(s) 

▪ When the  TOpenGLFont call is used at startup, the 

custom applications hangs.     

Several glXUseXFont()-related fixes were missing from 

hclglx.dll, which has since been updated.  

 

5.4.13 Issues resolved in Hot Fix 10 

This section lists the issues initially resolved in Hot Fix 10. 

JID Description Affected 

Component(s) 

CONN-3747 Resolved an issue that could cause Exceed to crash if 

BackingStores was set to Always.  

Exceed 

 

5.4.14 Issues resolved in Hot Fix 9 

This section lists the issues initially resolved in Hot Fix 9. 

JID Description Affected   

CONN-3718 Resolved two intermittent HostExplorer issues, which 

were observed in the following context: 

▪ Multiple HostExplorer sessions were running with the 

same profile -and- 

▪ The user selected Exit All, from the File menu.  

Issue 1   

An error message may be displayed:  

HostExplorer   
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JID Description Affected   

The process cannot access the file 

because it is being used by another 

process. 

This happens when there is a race condition while 

accessing the .hep file from multiple sessions (timing 

issue, not persistent). 

Issue 2 

A crash may occur. This happens when the user clicks 

any menu item on the terminal window that is about to be 

terminated (timing issue, not persistent).    

5.4.15 Issues resolved in Hot Fix 8 

This section lists the issues initially resolved in Hot Fix 8. 

JID Description Affected   

CONN-3731 Resolved an issue that caused the scp2.exe to crash 

when a single file was copied. The issue was observed in 

the following observed: 

▪ From a command prompt run  

scp2.exe -B [file name] [user]#[user@host: 

[target dir] 

OpenText 

Connectivity Secure 

Shell   

 

5.4.16 Issues resolved in Hot Fix 7 

This section lists the issues initially resolved in Hot Fix 7. 

JID Description Affected   

CONN-3730 Resolved the following HostExplorer issue:  HostExplorer   
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JID Description Affected   

▪ During VT Session the column change request 

from host was not being honored. 

 

5.4.17 Issues resolved in Hot Fix 6 

This section lists the issues initially resolved in Hot Fix 6. 

JID Description Affected   

CONN-3720 Resolved a HostExplorer FTP profile issue—the system 

could not find the path where the user wanted to save 

the profile.  When caching the location of the current 

USERDIR the file mapping used for the cache could fail, 

which resulted in incorrect paths returned.  The issue has 

been fixed. HostExplorer FTP profiles may now be saved 

to the specified location.  

HostExplorer   

 

5.4.18 Issues resolved in Hot Fix 4 

This section lists the issues initially resolved in Hot Fix 4. 

JID Description Affected   

CONN-3727 Resolved a crash issue related to HostExplorer session 

connections established via a dial-up modem. The issue 

happened when the user invoked a profile before a  

previous session was closed completely. 

HostExplorer 

 

5.4.19 Issues resolved in Hot Fix 3 

This section lists the issues initially resolved in Hot Fix 3. 
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JID Description Affected 

Component(s) 

CONN-3716 Resolved a HostExplorer crash issue that occurred in in the 

following context:  

1. Run Exceed and HostExplorer sessions, in a multiple 

monitor configuration, with a laptop.  

2. Maximize the HostExplorer window. HostExplorer 

crashes.   

HostExplorer 

 

5.4.20 Issues resolved in Hot Fix 2 

This section lists the issues initially resolved in Hot Fix 2. 

JID Description Affected 

Component(s) 

CONN-3590  Resolved the following issue affecting Exceed 15.0:  

▪ User connected the Wacom tablet to Windows 10 as a 

mouse input device, and then used the screen as well as 

the stylus to control the mouse pointer on Windows 10. 

When the user established a session with Linux using 

XDMCP, the stylus on the Wacom tablet did not function in 

the Exceed session but worked outside of it on Windows 

10.   

This occurred because the valuators in XInput devices were 

not correctly specified.  Not all X applications worked with the 

XInput extension.  

To fix the issue set the following:  

Under:  

HK_LOCAL_MACHINE\Software\Hummingbird\Connecti

vity\15.00\Exceed\XServer: 

XinputWinTablet (DWORD) 0  

Exceed 
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JID Description Affected 

Component(s) 

To restore the original behavior: 

Remove the flag completely or set it to 1 as follows:  

HK_LOCAL_MACHINE\Software\Hummingbird\Connecti

vity\15.00\Exceed\XServer: 

XinputWinTablet (DWORD) 1  

Note: When the flag is set to 1, this forces a stylus to generate 

the XInput extension events for X applications that are Xinput 

aware (especially when they run in the Exceed passive 

mode).  That is, by default, Exceed allows the Windows tablet 

stylus to act as the Windows native pointer device (so that 

tablets in Exceed windows behave as in other Windows 

applications). 

5.4.21 Issues resolved in Hot Fix 1 

This section lists the issues initially resolved in Hot Fix 1. 

JID Description Affected 

Component(s) 

CONN-3426 Resolved the following issue, detected during an 

upgrade and affecting Windows Explorer:  

• Windows Explorer does not restart if any 

Connectivity 15 product is installed.  For 

instance, Exceed is upgraded from V14 to V15, 

using System Center Configuration Management 

(SCCM). This hot fix disables the MSI integration 

with Restart Manager, and thus prevents the 

Windows Explorer shutdown, for upgrades and 

installations performed using SCCM.   

Installer 
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JID Description Affected 

Component(s) 

This hot fix applies to all Version 15 OpenText 

Connectivity products. It does not apply to OpenText 

Exceed 3D and 3Dx64.  

 

6 Connectivity 15.0.5 (Service Pack 5) 

This section lists the new features, resolved issues, and known issues of OpenText Connectivity, 

Version 15.0.5, also known as Version 15.0, Service Pack 5.   

6.1 New features and enhancements in Connectivity 15.0.5 

This section lists the new features and enhancements implemented in Connectivity 15.0.5 (Service 

Pack 5).    

6.1.1 Windows 10 certification (Exceed, HostExplorer and Secure Shell)  

The following Connectivity products have been certified as Compatible with Windows 10: 

• OpenText Exceed 

• OpenText HostExplorer 

• OpenText Secure Shell  

Version 15.0 of the above products is also certified as Compatible with Windows 7 and Windows 8. 
 

JIRA ID: CONN-3443 

6.1.2 New OpenSSL Version 

OpenSSL libraries have been updated from version 1.0.2k to 1.0.2n.  For a list of high level changes, 

refer to the OpenSSL Release Notes: 

 
https://www.openssl.org/news/openssl-1.0.2-notes.html 
 

JIRA ID: CONN-3520 

https://www.openssl.org/news/openssl-1.0.2-notes.html
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6.1.3 Forcing validation of server certificates for all HostExplorer profiles  

HostExplorer now supports a new option to always verify the server certificate when establishing an 

SSL connection. To enable this option, you must add a new flag to the to HostEx.ini file. This flag 

overrides individual profile settings, ensuring that the host certificate will always be verified regardless 

of individual profile settings.   

To force validation of server certificate for all HE profiles: 

1. Using a text editor, open the HostEx.ini file from the following locations:  

Per User Installation: 

%AppData%\Hummingbird\Connectivity\15.00\HostExplorer\HostEx.ini 

Shared User Directory installation:  

%ProgramData%\Hummingbird\Connectivity\15.00\Shared\HostExplorer\HostEx

.ini 

2. Add the following flag:  

[Force Verify Certificate] 

HDFUBValue=1 

3. Save the file. 

Note: Setting the [Force Verify Certificate] flag will select and disable the following 

option in all HostExplorer 3270, 5250 and VT profiles:  

Security > SSL / TLS > Verify Server Certificate 

JIRA ID: CONN-3470 

6.1.4 Setting the Minimum Encryption Level for FTP/SSL profiles 

Connection Central now supports a global FTP option to specify the minimum encryption level when 

establishing FTPS or SFTP connections. You may choose among the following options:  

• SSL Version 3 

• TLS Version 1 

• TLS Version 1.1 

• TLS Version 1.2 

Note: SSL Version 2 may be added to the menu, by enabling this protocol in the HEshell.ini file.   
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The Minimum Encryption Level can be set in the FTP General settings in Connection Central.  

  
To select the Minimum Encryption Level:  

1. Open Connection Central, press Alt to bring up the menu bar, select View > Connection 

Central Options, and then click the FTP General tab.  

2. From the Minimum Encryption Level menu, select the preferred option. The default menu is 

shown below: 

 

What happens when you select an option from the Minimum Encryption Level menu?  

The Minimum Encryption Level determines which encryption levels are available in the SSL settings 

for FTP – SSL / TLS profiles. This option also enforces the minimum encryption level at runtime, so 

that an older FTP profile that specifies a lower encryption level will be overridden by the global setting. 

JIRA ID: CONN-3454 
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6.1.5 High DPI monitor support for Exceed, HostExplorer, Secure Shell 

Exceed, HostExplorer and OpenText Secure Shell now support high DPI monitors, so users will no 

longer see blurry text and graphics in application windows (Xstart, Xconfig, HostExplorer sessions, 

SSH tunnel configuration, etc.) 

Connectivity 15.0.5 supports the following high-DPI modes: 

• Per-Monitor (V1) for Windows 7 and 8  

• Per-Monitor (V2) for Windows 10 

 

For a description of Per-Monitor (V1) and Per-Monitor (V2) DPI modes, please refer to this Microsoft 

support article.  

 

JIRA ID: CONN-3495 

6.1.6 New default and maximum values of the Default window size   

The following changes have been made to the Tunnel Profile settings in Secure Shell: 

• The Default window size has been increased from 4KB to 128KB 

• The maximum value for the Default window size in SSH tunnel settings has increased from 

64KB to 4MB. Increasing this setting can result in much faster performance on modern, high-

speed networks.    

To modify the Default Window size: 

1. Start OpenText Secure Shell Console, and then perform the required steps, depending on the 

profile type: 

For…    Do this… 

 New profile From the File menu, select New Tunnel, and then click 

Properties. The Tunnel Profile window is displayed.  

Existing profile  Right-click the profile, and then click Properties.  The Tunnel 

Profile window is displayed. 

2. Under Connection category, display the Advanced tab.  

3. Under Default Window Size, enter the preferred value.  

https://msdn.microsoft.com/en-us/library/windows/desktop/dd940516(v=vs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/dd940516(v=vs.85).aspx
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4. Click OK.  

 

JIRA ID: CONN-3295; CONN-3506 

6.1.7 New OIA options for displaying the Caps Lock/Shift/Num Lock indicators 

New profile options have been added, enabling you to display the Num Lock, Caps Lock and Shift 

status in the Operator Information Area (3270 and 5250 profiles), or Status Line (VT profiles).   

These options are available under Display > OIA Options (3270 and 5250), or Display > Status 

Line (VT).  For further details, see the product documentation.  

If the options are enabled, activating the Caps Lock, Num Lock or Shift keys will display a visual 

indicator in the OIA or status line.   

New OIA option   Visual indicator in the OIA/Status Line 

Display Caps Lock indicator A 
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New OIA option   Visual indicator in the OIA/Status Line 

Display Num Lock indicator # 

Display Shift indicator ↑    

 

 

JIRA ID: CONN-870 

6.1.8 Outlining the HostExplorer workspace   

The HostExplorer workspace may now be outlined with a border. New profile options enable you to 

control the colour and dot pattern of the workspace border.  

Note: By default, the border colour is set to White, and the border pattern is Solid.  

The new options are available under Session Window > Workspace in the profile settings. 
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For further details, see the product documentation.   

 

JIRA ID: CONN-2774 

6.1.9 Specifying a directory for the Macro-List function 

HostExplorer allows you to add the Macro-List function to a toolbar or menu. When the user clicks the 

Macro-List item on the toolbar, a list of the available macros is displayed. Previously, this list 

contained only the macros from the default directory.  

Users can now specify a different directory from which HostExplorer obtains the macros.   

To specify a directory for the Macro-List function:  

1. Go to Options > Global Options > Advanced tab > Run Macro from Path.  

2. Enter the path of the directory that contains the macros you want to add to the Macro-List menu.  

To add the Macro-List function to the toolbar and run a macro: 

1. Go to Tools > Customize Toolbar > Functions tab.  

2. Drag the Macro-List item to the toolbar at the top.  

3. Click the Macro-List item on the toolbar. This displays a dropdown list of macros you can run. 
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4. Select a macro of your choice, and run it.   

 

JIRA ID: CONN-170 

6.2 New features in Connectivity 15.0.4 hot fixes 

The following new features were added via hot fixes, after the release of Connectivity 15.0.4, and 

prior to completion of Connectivity 15.0.5 release. All the hot fixes are cumulative and included in the 

15.0.5 release. 

6.2.1 New feature in Hot Fix 5 

This section lists the features and/or enhancements added in Connectivity 15.0.4 Hot Fix 5. 

JIRA ID Description Affected 

Component(s) 

CONN-3449 The following functionality has been introduced: 

• TLS 1.2 and TLS 1.1 support for the Classic FTP 

application.   

 

• The ability to accept the highest TLS version 

suggested by the server. For this functionality to 

work, the user needs to select the following option 

from the Security menu, in the Open Connection  

dialog box: 

 

 Classic FTP 
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JIRA ID Description Affected 

Component(s) 

o Highest TLS 

6.2.2 New feature in Hot Fix 4 

This section lists the features and/or enhancements added in Connectivity 15.0.4 Hot Fix 4. 

JIRA ID Description Affected 

Component(s) 

CONN-3428 Restored the Extend / HCL-DOS-Access functionality, which was 

removed in Exceed 15. The following flags support this 

functionality:  

HCLDOSAccess=1 (DWORD)  

-and- 

HCLDOSAccessPassword=password (String) 

Example:  

[HKEY_LOCAL_MACHINE\SOFTWARE\Hummingbird\Connectivity

\15.00\Exceed\Xserver] 

"HCLDOSAccess"=dword: 0x00000001 (1) 

"HCLDOSAccessPassword"="password" 

Exceed 
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6.3 Issues resolved in Connectivity 15.0.5  

JIRA ID Description Affected 

Component(s) 

CONN-3588 Resolved an issue where HostExplorer FTP was showing file icons 

instead of folder icons in Windows 10.  

HostExplorer 

FTP 

CONN-3573 Resolved the following issue:  

• When Xstart was initially launched, the following error was 

displayed:  

Failed to CoCreateInstance Secure Shell 

Manager. 

The second attempt to launch was successful. The issue 

occurred during the initial login only.   

Exceed 

CONN-3549 Resolved the following issue:  

• When the GetSessionWindow method was used, the 

following error message appeared:  

Object method returned an unsupported data type  

The issue was caused by mismatched data types (a 64-bit data 

type in the HostExplorer component and 32-bit in the ebasic 

component). 

HostExplorer 

CONN-3528 Resolved an issue where local X applications using OpenGL would 

crash when destroying a GLXContext if the context was no longer 

current. 

Exceed 3D 
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JIRA ID Description Affected 

Component(s) 

CONN-3437 Resolved a font issue detected with Connectivity 15.0.4. The font 

size displayed in a customer application was too large.  

Exceed 

CONN-3420 Resolved the following issue detected in HostExplorer, after 

migration from version 14 to version 15:  

• The cursor position is unexpectedly shifted to a different 

field, after a macro is executed.  The initial cursor position 

was displayed correctly, in a non-editable field. After the 

macro was executed, and the next record was presented, 

the cursor was not displayed in the initial position but was 

positioned in the next editable field. 

HostExplorer 

CONN-3283 Provided a workaround in Exceed 15, where the right edge of the 

Cashbox application window was not visible.  

To apply the workaround: 

1. Open the following location in the Windows registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\Hummingbird\Connectivity

\15.00\Exceed\Xserver 

-or- 

HKEY_CURRENT_USER\Software\Hummingbird\Connectivity\

15.00\Exceed\XServer 

2. Set the StartMaximize flag as follows: 

StartMaximize=(DWORD) 1  

Note: This setting takes effect on a single monitor system only.  

Exceed 

CONN-3062 Resolved the following security issue:  

Passwords entered interactively were cached, for a time period 

defined by the setting Credentials cache expires after (mins), even 

for the profiles that were configured not to contain them.  

Connection 

Central 
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JIRA ID Description Affected 

Component(s) 

This local storage invalidated the purpose of creating a profile that 

required the end user to enter the password at run-time. Such 

passwords are no longer stored in a cache file.  

 

6.4 Issues resolved in Connectivity 15.0.4 hot fixes 

The following issues were resolved in hot fixes after the release of Connectivity 15.0.4, and prior to 

completion of Connectivity 15.0.5 release. All the hot fixes are cumulative and included in the 15.0.5 

release. 

6.4.1 Issues resolved in Hot Fix 3 

This section lists the issues initially resolved in Hot Fix 3. 

JIRA ID Description Affected 

Component(s) 

CONN-3182 Resolved a memory leak, observed with Exceed version 

15 and the HumShSrv.exe process, which consumed 

high memory and thus caused the computer to freeze.   

HumTunnel.dll 

6.4.2 Issues resolved in Hot Fix 2 

This section lists the issues initially resolved in Hot Fix 2. 

JIRA ID Description Affected 

Component(s) 

CONN-3412 Resolved a drawing issue observed with Exceed Version 

15:   

• Content was not refreshed correctly when the 

option backingStore was set to Always. 

Some areas were not redrawn as expected (gray 

areas were displayed instead).   

Exceed 
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JIRA ID Description Affected 

Component(s) 

The issue was not caused by Exceed, but a behavior of 

3rd party application(s).  The hot fix provides a 

workaround for this issue.  

6.4.3 Issues resolved in Hot Fix 1 

This section lists the issues initially resolved in Hot Fix 1. 

JIRA ID Description Affected 

Component(s) 

CONN-3387 Resolved the following issue:  

Left mouse button is not released, after the mouse 

pointer is moved out of the X window. The issue occurred 

in a multi-monitor environment, with Exceed configured 

to run in Single Window Mode. The issue was detected 

after an upgrade from Exceed 7 on Windows 7 to Exceed 

15 on Windows 10. 

The issue was detected in the following context:  

1. Launch Gnome-session, and then open a 

terminal or text editor.  

2. Select some text without releasing the left mouse 

button. Then move the cursor out of the Exceed 

main window.  

3. Release the left mouse button (even type in the 

text editor window).  

4. Return to Exceed main window. The selection 

keeps updating, as if the left mouse button is still 

pressed.   

Exceed 

CONN-3393 Resolved a drawing issue observed with Exceed Version 

15, in Multiple Window Mode:   

Exceed 
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JIRA ID Description Affected 

Component(s) 

• Text from the menu remained on the screen when 

the user switched to the next screen.   

The issue was related to the update of unmapped 

backingStore=Always windows. The hot fix ensures 

that, if a window is not realized, it is not automatically 

painted onto its parents. 

 

6.5 Known issues in Connectivity 15.0.5 

JIRA ID Known issue 

CONN-3668 The following known issue was detected in SP5 but may exist in preceding 

releases:  

• A Web Deployment project that uses the option Ensure only FIPS 

Validated Cryptography is used fails to load OpenSSL DLLs for a VT 

deployment. To deploy the project properly, you must reboot the machine 

and log into Windows again.   

The issue was detected in the following context.  

1. Install Exceed/Secure Shell on a local machine. During the installation 

process, make sure that the following option is selected in the Setup Type 

window: Ensure only FIPS Validated Cryptography is used.    

2. Create a VT profile that has SSL security enabled, and then create a 

deployment project for this profile. 

3. Deploy it on a client machine.   

4. The following message is displayed:  

Failed to load OpenSSL DLLs   

CONN-2774 The new Workspace Border options are not added during migration.  If you have 

used the Files and Settings Transfer Wizard to migrate an earlier version of Exceed 

or HostExplorer to version 15, the Workspace border options will not appear in 

HostExplorer session properties. 
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JIRA ID Known issue 

Background: 

The Default User\HostExplorer\Session Properties\Default xxx.spX 

files will be updated, however, it is possible that during migration or after applying 

the patch the file contents of the users’ Session Properties will have been modified 

by them, and consequently will not be updated. 

Workaround: The users should copy the Default xxx.spX files into their own 

user directory, and thus overwrite any changes they may have made. 
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7 Connectivity 15.0.4 (Service Pack 4) 

This section lists the new features, resolved issues, and known issues of OpenText Connectivity, 

Version 15.0.4, also known as Version 15.0, Service Pack 4.   

7.1 New features and enhancements in Connectivity 15.0.4 

This section lists the new features implemented in this service pack.  

7.1.1 Proprietary files replace the .fon files, for increased security  

During installation, Exceed now provides proprietary .wff font files, instead of the .fon files.  

Note: Windows 10 prevents .FON files from being loaded from locations outside the Windows Font 

folder. The existence of the proprietary files ensures that Exceed 15 fonts work as expected on 

Windows 10 and that font security issues do not occur. Previously existing .FON files are replaced 

with .wff font files, and the font database files (.fdb) are updated accordingly.  

Note: Some outdated .fon files have been removed but not replaced, due to being obsolete.  

The following sections lists both the removed files, and the new .wff files added to the extra 

directory.   

7.1.1.1 Files that have been removed but not replaced 

Please see the table below, for a full list of outdated and removed font files, which have not been 

replaced by the equivalent .wff files.  

Type of the 

outdated 

.fon files  

Removed from 

this directory… 

Name of the removed and not replaced .fon file(s)   

Custom font 

files, created 

by OpenText 

chinese   cns11643-1.100-100.fon 

cns11643-1.120-100.fon 

cns11643-1.140-100.fon 

cns11643-1.160-100.fon 

cns11643-1.200-100.fon 

cns11643-1-120.fon 

cns11643-1-140.fon 

cns11643-1-160.fon 

cns11643-1-200.fon 

cns11643-1-240.fon 

gb18030.2000--120.fon 

gb18030.2000--140.fon 

gb18030.2000--160.fon 

gb18030.2000--200.fon 
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Type of the 

outdated 

.fon files  

Removed from 

this directory… 

Name of the removed and not replaced .fon file(s)   

gb18030.2000--240.fon 

gb18030.2000-0.100-100.fon 

gb18030.2000-0.120-100.fon 

gb18030.2000-0.140-100.fon 

gb18030.2000-0.160-100.fon 

gb18030.2000-0.200-100.fon 

gbk-0.100-100.fon 

gbk-0.120-100.fon 

gbk-0.140-100.fon 

gbk-0.160-100.fon 

gbk-0.200-100.fon  

gbk-0-120.fon 

gbk-0-140.fon 

gbk-0-160.fon 

gbk-0-200.fon 

gbk-0-240.fon 

extra johab13p.fon 

korean 18x18ko-johab.fon 

 TTF batang.ttf 

dotum.ttf 

gulim.ttf 

hline.ttf 

luximb.ttf 

luximbi.ttf 

luximr.ttf 

luximri.ttf 

luxirb.ttf 

luxirbi.ttf 

luxirr.ttf 

luxirri.ttf 

luxisb.ttf 

luxisbi.ttf 

luxisr.ttf 

luxisri.ttf 

sazanami-gothic.ttf 

sazanami-mincho.ttf 

SyrCOMAdiabene.otf 

SyrCOMAntioch.otf 
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Type of the 

outdated 

.fon files  

Removed from 

this directory… 

Name of the removed and not replaced .fon file(s)   

SyrCOMBatnan.otf 

SyrCOMBatnanBold.otf 

SyrCOMCtesiphon.otf 

SyrCOMEdessa.otf 

SyrCOMJerusalem.otf 

SyrCOMJerusalemBold.otf 

SyrCOMJerusalemItalic.otf 

SyrCOMJerusalemOutline.otf 

SyrCOMKharput.otf 

SyrCOMMalankara.otf 

SyrCOMMardin.otf 

SyrCOMMardinBold.otf 

SyrCOMMidyat.otf 

SyrCOMNisibin.otf 

SyrCOMNisibinOutline.otf 

SyrCOMQenNeshrin.otf 

SyrCOMTalada.otf 

SyrCOMTurAbdin.otf 

SyrCOMUrhoy.otf 

SyrCOMUrhoyBold.otf 

uming.ttf 

Vera.ttf 

VeraBd.ttf 

VeraBI.ttf 

VeraIt.ttf 

VeraMoBd.ttf 

VeraMoBI.ttf 

VeraMoIt.ttf 

VeraMono.ttf 

VeraSe.ttf 

VeraSeBd.ttf 

Other misc lookg10.fon 

lookg10b.fon 
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7.1.1.2 Files added to the extra font directory 

The following font files have been added to the extra directory: 

10x20-iso8859-11.wff 

10x20-iso8859-13.wff 

10x20-iso8859-2.wff 

10x20-iso8859-4.wff 

10x20-iso8859-5.wff 

10x20-iso8859-7.wff 

10x20-iso8859-8.wff 

10x20-iso8859-9.wff 

12x13-iso8859-1.wff 

12x13-iso8859-13.wff 

12x13-iso8859-2.wff 

12x13-iso8859-4.wff 

12x13-iso8859-5.wff 

12x13-iso8859-7.wff 

12x13-iso8859-8.wff 

12x13-iso8859-9.wff 

18x18-iso8859-1.wff 

18x18-iso8859-13.wff 

18x18-iso8859-2.wff 

18x18-iso8859-4.wff 

18x18-iso8859-5.wff 

18x18-iso8859-7.wff 
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18x18-iso8859-9.wff 

6x13-iso8859-13.wff 

6x13-iso8859-2.wff 

6x13-iso8859-4.wff 

6x13-iso8859-5.wff 

6x13-iso8859-7.wff 

6x13-iso8859-8.wff 

6x13-iso8859-9.wff 

6x13b-iso8859-13.wff 

6x13b-iso8859-2.wff 

6x13b-iso8859-4.wff 

6x13b-iso8859-5.wff 

6x13b-iso8859-7.wff 

6x13b-iso8859-8.wff 

6x13b-iso8859-9.wff 

7x14-iso8859-11.wff 

7x14-iso8859-13.wff 

7x14-iso8859-2.wff 

7x14-iso8859-4.wff 

7x14-iso8859-5.wff 

7x14-iso8859-7.wff 

7x14-iso8859-8.wff 

7x14-iso8859-9.wff 

7x14b-iso8859-11.wff 
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7x14b-iso8859-13.wff 

7x14b-iso8859-2.wff 

7x14b-iso8859-4.wff 

7x14b-iso8859-5.wff 

7x14b-iso8859-7.wff 

7x14b-iso8859-8.wff 

7x14b-iso8859-9.wff 

8x13-iso8859-11.wff 

8x13-iso8859-13.wff 

8x13-iso8859-2.wff 

8x13-iso8859-4.wff 

8x13-iso8859-5.wff 

8x13-iso8859-7.wff 

8x13-iso8859-8.wff 

8x13-iso8859-9.wff 

8x13b-iso8859-13.wff 

8x13b-iso8859-4.wff 

8x13b-iso8859-7.wff 

8x13b-iso8859-8.wff 

8x13b-iso8859-9.wff 

9x15-iso8859-11.wff 

9x15-iso8859-13.wff 

9x15-iso8859-2.wff 

9x15-iso8859-4.wff 
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9x15-iso8859-5.wff 

9x15-iso8859-7.wff 

9x15-iso8859-8.wff 

9x15-iso8859-9.wff 

9x15b-iso8859-11.wff 

9x15b-iso8859-13.wff 

9x15b-iso8859-2.wff 

9x15b-iso8859-4.wff 

9x15b-iso8859-5.wff 

9x15b-iso8859-7.wff 

9x15b-iso8859-8.wff 

9x15b-iso8859-9.wff 

9x18-iso8859-11.wff 

9x18-iso8859-13.wff 

9x18-iso8859-2.wff 

9x18-iso8859-4.wff 

9x18-iso8859-5.wff 

9x18-iso8859-7.wff 

9x18-iso8859-8.wff 

9x18b-iso8859-13.wff 

9x18b-iso8859-2.wff 

9x18b-iso8859-4.wff 

9x18b-iso8859-5.wff 

9x18b-iso8859-7.wff 
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9x18b-iso8859-8.wff 

JIRA ID: CONN-3329; CONN-3330 

 

7.2 New features introduced in Connectivity 15.0.3 hot fixes  

The following new features were added via hot fixes, after the release of Connectivity 15.0.3, and 

prior to completion of Connectivity 15.0.4 release.  

JIRA ID Description Products affected   

CONN-3273 This new command line parameter option has been 

added, for Connectivity Cleanup tool: 

NFS14Only=1 

The parameter ensures that the Connectivity Version 14 

User folder content (not required by NFS Solo) is cleaned 

up, even though NFS Solo is installed.  

Note: The emptied folder may still exist after the cleanup, 

but will have no contents.  

Exceed and 

HostExplorer   

 

Note: The hot fix is 

not to be included in 

NFS Solo Version 

14 or any 

Connectivity Version 

14 product. 

 

 

7.3 Issues resolved in Connectivity 15.0.4    

The following issues were resolved in Connectivity 15.0.4 release.  

 JIRA ID Description Affected 

Component(s) 

CONN-3275 Resolved the following issue with the Application Close 

method:  

• Close Handler from a customer application 

did not work correctly, in Exceed. When 

installed, it failed to work if a popup menu was 

opened. 

Exceed 
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7.4 Issues resolved in Connectivity 15.0.3 hot fixes  

The following issues were resolved in hot fixes after the release of Connectivity 15.0.3, and prior to 

completion of Connectivity 15.0.4 release.  

Note: All the hot fixes are cumulative and included in the 15.0.4 release. The exception for 15.0.4 is 

Hot Fix 6.  

 JIRA ID Description Affected 

Component(s) 

Hot Fix 1 

CONN-3303 Resolved a key-mapping issue related to a physical 

German keyboard. All the keys generated by using AltGr 

produced no output.  

Exceed 

CONN-3302 Resolved a key-mapping issue related to a physical 

French keyboard. All the keys generated by using AltGr 

produced no output. For example, the key combination 

”AltGr + 0” displayed nothing on the screen, instead of the 

expected “@” character. 

Exceed 

Hot Fix 2 

CONN-3303 Resolved a key-mapping issue related to a physical 

German keyboard. All the keys generated by using AltGr 

produced no output.  

Exceed 

CONN-3302 Resolved a key-mapping issue related to a physical 

French keyboard. All the keys generated by using AltGr 

produced no output. For example, the key combination 

”AltGr + 0” displayed nothing on the screen, instead of the 

expected “@” character. 

Exceed 

Hot Fix 3 

CONN-3313 Resolved the following font related issue, affecting Exceed 

version 15.0.3:  

Exceed 
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 JIRA ID Description Affected 

Component(s) 

• Japanese font code #xx40 could not be 

displayed.    

CONN-3303 Resolved a key-mapping issue related to a physical 

German keyboard. All the keys generated by using AltGr 

produced no output.  

Exceed 

CONN-3302 Resolved a key-mapping issue related to a physical 

French keyboard. All the keys generated by using AltGr 

produced no output. For example, the key combination 

AltGr + 0 did not display the expected @ character 

(nor any other character).  

Exceed 

Hot Fix 4 

CONN-3315 Resolved the following issue: 

• Lowercase characters are displayed although the 

Caps Lock key is turned on 

The issue occurred in the following context:  

• The XKeyboard extension was disabled in the 

Xconfig file. The Caps Lock key was enabled 

before Exceed was started.  

Exceed 

CONN-3297 Fixed the behavior of Root Mouse To X without 

Aero, which previously caused drawing problems. I.e., 

the Xroot background was not refreshed and the 

fragments of the previous video information still remained 

on the screen.  

Exceed 

Hot Fix 7 

CONN-3319 Resolved the following  issue: 

• During both import and export of settings the Files 

and Settings Wizard uses temporary files to 

FSTWizard.exe       

humpufst.dll 

humtsfst.dll    
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 JIRA ID Description Affected 

Component(s) 

generate the database of settings used. The 

same temporary name could be used multiple 

times during this process and this could cause a 

problem if the file became locked (due to 3rd Party 

virus scanning or similar causes).   

To avoid this problem, all temporary files that are used 

now have unique names.   

 

8 Connectivity 15.0.3 (Service Pack 3) 

This section lists the new features, resolved issues, and known issues of OpenText Connectivity, 

Version 15.0.3, also known as Version 15.0, Service Pack 3.   

8.1 New features and enhancements in Connectivity 15.0.3 

This section lists the new features implemented in this service pack.  

8.1.1 New OpenSSL Version 

OpenSSL files have been updated from OpenSSL 1.0.1g to OpenSSL 1.0.2k.  

JIRA ID: CONN-3159 

8.1.2 Support for SHA-2 SSL certificates 

The ActiveX and Java web deployment packages are now signed with SHA2 certificates.  This 

ensures that web deployed projects can be used with modern browsers.  

JIRA ID: CONN-3196 

8.1.3 Connectivity Exceed XDK support for Visual Studio 2015 

Connectivity Exceed XDK now provides support for MS Visual Studio 2015.  

To build the X client using Visual Studio 2015 ( VC++ 14) or a later version of MS Visual Studio, users 

of XDK should use xlib-vc14.lib and legacy_stdio_definitions.lib, instead of the 

original xlib.lib.  
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JIRA ID: CONN-3222         

8.1.4 Ability to migrate Enable FIPS value for all the existing profiles  

The HostExplorer user interface now migrates FIPS Only profile value from Connectivity Version 14 to 

Version 15. The value is reflected on the SSL/TLS session profile tab.  

The migration of the existing profile values may affect the connection behavior (depending on the 

value of Default Cryptographic Mode setting in the Registry).    

Note: Previously, Connectivity did not force profile states to be reflected in the user interface, upon 

migration to a new version. By design, it ensured that only the FIPS only version can be started, 

thus, the profile states were not taken into account.   

8.1.4.1 Interaction of Enable FIPS Profile Flag and Security Registry 

Settings 

The following variables determine what is displayed in the HostExplorer user interface, for the Enable 

FIPS option, as well as what happens when a connection is made:  

1) Registry setting Default Cryptographic Mode (1==Unrestricted, 2=FIPS, 3=Both) 

2) Registry settings pointing to the installed path of the OpenSSL libraries – two sets 

a. FIPS libraries 

b. unrestricted libraries 

3) Within the HostExplorer profile, the CryptographicMode setting, which reflects the value in the 

user interface for the Enable FIPS check box. 

There are two real-world scenarios, based on the Default Cryptographic Mode.  

• When all libraries are present, you can use the Enable FIPS check box.  

• When only the FIPS libraries are present, you cannot. 

Default 

Cryptographic 

Mode 

Libraries 

installed 

User interface behaviour Connection 

behaviour 

1 or 2 or 3 All libraries 

present 

The Enable FIPS option is enabled.  

 

Reflects the profile value. 

Obeys the 

profile value 

(that is, FIPS 

or not) 

2 Only FIPS 

libraries 

present 

Enable FIPS is not enabled, and checked 

(i.e., FIPS ONLY) – if profile is saved, 

Cryptographic Mode set to 2 (FIPS) 

Connects in 

FIPS mode 

only 
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JIRA ID: CONN-3201  

8.1.5 Hiding the Paste Continue message box to speed up pasting of content   

A new Global Option in HostExplorer allows you to hide a message box that is, by default, shown 

when content is pasted into a HostExplorer screen.   

Previously, in HostExplorer, the user who copied more data than the number of fields available on 

screen, had to follow this procedure: 

1. Paste the text. Clear the following message box, before being able to continue with pasting 
content: 

More text available in clipboard. Use Paste Continue. 

2. Press ENTER, to position the cursor in the first field of the next input line.   

This procedure had to be repeated for each line of text to be pasted.  

To simplify pasting of data, the following HostExplorer Global Option has been added, to the 

Advanced group of options:  

Show Paste Continue Dialog  
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The option allows you to enable or disable the message box, which by default appears after a line is 

pasted into a HostExplorer screen. Hiding the dialog box will speed up pasting, by eliminating 

unnecessary steps of having to remove the dialog box prior to proceeding.   

By default, the Show Paste Continue Dialog check box is selected. Clear this check box, and 

restart HostExplorer, to avoid showing the message box, when pasting data.  

JIRA ID: CONN-3183  

8.1.6 Displaying the 3270 application name in the HostExplorer window title 

The 3270 session's application name can now be shown in the HostExplorer window title. The 

following new display variable has been added to the session profile, under Session Window > 

General > Window title:  

Host Application name (%x) 

 

This option is available for 3270 only. It is not available for the 5250 or VT sessions. 

JIRA ID: CONN-3181 
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8.1.7 Multiple X-selection support  

Exceed now supports copying and pasting across multiple X selection buffers, without the need to 

modify Xconfig and restart the session. 

When data is added to any X selection buffer (PRIMARY, SECONDARY, CLIPBOARD, 

CUT_BUFFER0, etc.) it is copied to the local Windows clipboard.  Previously, only a single X 

selection buffer, specified by the X Selection Associated With Edit Operations property 

in Xconfig, was copied to the Windows clipboard.  

Note: You may restore the previous behavior (only copy data to the Windows clipboard from the 

specified X selection). To do so, use the following flag: 

XSelCopyUseOneBuffer=1 (DWORD) 

 

Additionally, if X Selection Associated With Edit Operations is set to PRIMARY in 

Xconfig, the Windows clipboard data will be copied to both the PRIMARY and CLIPBOARD X 

selections, making the data available to applications that use either the PRIMARY or CLIPBOARD X 

selection.  

Note: You may restore the previous behavior (only write to the PRIMARY X selection when PRIMARY 

is selected).  To do so, set the following flag:  

EraseXSelClipboard=0 (DWORD) 

Note: Both flags can be added in two places: 

• By modifying the exceed.xcfg configuration file. 

• In the desktop Registry as follows: 

 

Only current user (both 32bit and 64bit): 
HKEY_CURRENT_USER\Software\Hummingbird\Connectivity\15.00\Exceed\XServer  

 

All users -- 64bit: 

HKEY_LOCAL_MACHINE\Software\Hummingbird\Connectivity\15.00\Exceed\XServer 

 

All users -- 32bit 

HKEY_LOCAL_MACHINE\Software\Wow6432Node\Hummingbird\Connectivity\15.00\Excee

d\XServer 

JIRA ID: CONN-3124        
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8.1.8 Ability to hide items in the Exceed taskbar 

As an Exceed user, you will find Exceed XDMCP Broadcast, Exceed XDMCP Query, Xconfig, Xstart 

and Xsession under Exceed Jump List.  

Starting with Version 15.0.3, you can now disable all options in the Jump List, except the Xconfig one.  

Jump lists Details 

Disabled New feature in 15.0.3. To disable the jump lists, configure the following DWORD (32-bit) 

flag, in the desktop Registry: 

NoJumpList  

The flag should be added to  

HKEY_CURRENT_USER\Software\Hummingbird\Connectivity\15.00\Exceed\XServer  

-or- 

HKEY_LOCAL_MACHINE\Software\Hummingbird\Connectivity\15.00\Exceed\XServer  

Enabled  Default condition. Right-click the Exceed icon on the task bar. Under Tasks, you can 

access the following list: 

Exceed XDMCP Broadcast 

Exceed XDMCP Query 

Xconfig 

Xstart 

Xsession 
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Jump lists Details 

 

 

JIRA ID: CONN3121 

8.1.9 New features added in 15.0.2 hot fixes 

The following features were added in hot fixes issued after the release of Connectivity 15.0.2, and 

prior to completion of Connectivity 15.0.3 release. All the hot fixes are cumulative and included in the 

15.0.3 release.  

JIRA ID Description Affected 

Component(s) 

Hot Fix 14 

CONN-

3179  

• In Hot Fix 14, the Motif Window Manager executable added the 

ResizeOpaque feature. This feature enables Motif Window Manager 

(MWM) to resize a window as a typical Windows OS window. MWM 

now relies on the following resource in the Mwm resource file: 

Mwm*moveOpaque: True 

Note: Both ResizeOpaque and MoveOpaque features may be used when 

moveOpaque is set to True.  

Exceed XDK 
 
mwm.exe 

 
 

Hot Fix 2 

CONN-3114 Resolved the following  keyboard related issue:   

• When a keyboard, such as  French.kbf keyboard, has keys serving 

as both a dead key and an AltGr generated key, the key with an AltGr 

state, such as [ on the French.kbf keyboard, may not work 

properly. 

That is, if you press the AltrGr + [  keys, the keyboard may not 

work as expected.   

Exceed 
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JIRA ID Description Affected 

Component(s) 

CONN-3092 Resolved an issue where Xconfig in Exceed could not be configured to work 

with multiple monitors. This monitor input error was related to Windows 10 

display customization feature (which provides the ability to configure the size of 

text, apps and other items to be greater than 100%). Xconfig could not be 

configured to work with multiple monitors, if one monitor size was configured to 

display text, apps and other items to a size greater than 100%.   

Once a monitor was configured, for example, to 125%, Xconfig showed the 
Monitor input error,  when the user tried to configure it to use the option: 

Use Monitor(s) - ALL: 

 

Connectivity 

Exceed / 

Xconfigs 
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JIRA ID Description Affected 

Component(s) 

 

Hot Fix 1 

CONN-3083 OpenSSL files have been updated from OpenSSL 1.0.1g to OpenSSL 1.0.2h.  
 
These major changes are introduced in OpenSSL 1.0.2h: 

• Prevented padding Oracle in AES-NI CBC MAC check (CVE-2016-
2107) 

• Fixed EVP_EncodeUpdate overflow (CVE-2016-2105) 

• Fixed EVP_EncryptUpdate overflow (CVE-2016-2106) 

• Prevented ASN.1 BIO excessive memory allocation (CVE-2016-2109) 

• EBCDIC over-read (CVE-2016-2176) 

• Modified behavior of ALPN, to invoke callback after SNI/servername 
callback, so that updates to the SSL_CTX affect ALPN. 

• Removed LOW from the DEFAULT cipher list. This removes singles 
DES from the default. 

• Ability to remove only the SSLv2 methods with the no-ssl2-method 
option. 

Connectivity 

 

8.2 Issues resolved in Connectivity 15.0.3 

JIRA ID Description Affected 

Component(s) 

CON-3258 Resolved the following issue: Exceed may crash. Exceed 
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JIRA ID Description Affected 

Component(s) 

CONN-3223 Resolved an issue where the user could not open a larger than display  

window, so a part of the window’s content was not shown. 

Exceed 

CONN-3185 Resolved the following issue, involving the Shift and Control keys 

states.  

• User logged into the Product Data Manager (PDM) and   

highlighted multiple items by holding down the Shift key. 

Initially, the highlighting worked as expected, but 

subsequently, it failed. The issue was observed on Exceed 

v15 with the SP2 installed.   

Exceed 

CONN-3175 After a CICS application was migrated from the mainframe to Tuxedo / 

Linux environment, behavior changed. 

In the mainframe, the input fields on the screen were differentiated 

with specific colors, which facilitated data entry.  

The input fields were not emphasized in the same way, after the 

migration. The fields on the entire application screen were displayed 

as if they were input fields.  

The screens in HostExplorer are now shown as they were displayed in 

the mainframe environment. 

 

HostExplorer 
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JIRA ID Description Affected 

Component(s) 

CONN-3172 

CONN-3100 

Resolved an issue caused by new TLS Client Authentication 

specifications for version TLS 1.2, which differ from all the previous 

versions. Version 15.0.3 of Connectivity implements the new 1.2 

specification and retains the earlier behavior for versions prior to TLS 

1.2 (1.1, 1.0, and SSL).  

HostExplorer 

HostExplorer FTP 

CONN-3170 Resolved a display issue with Motif windows, where a dropdown 

submenu was not shown correctly but was partially covered by the 

parent menu from which it was invoked. The parent dropdown menu 

and its submenus are now displayed correctly. 

Exceed 

CONN-3168 Resolved a keyboard related issue where an X application was 

correctly started and functional, until the user pressed the 

Ctrl+Alt+Delete shortcut, to reach the Window screen.  

When the user pressed the Cancel button, the Ctrl key remained 

pressed for X. Thus, the X windows could not be moved around and 

repositioned. 

Exceed 

CONN-3163 Resolved a timing issue affecting key events within a macro. The user 

had to hit a key twice before the macro would work.  

To resolve the issue, added a T<pause time in milliseconds> 

between two key events defined in the macro vectors.  

Example:   

[Macro.F9] 

Description="F9 as a macro of a, pause 10 seconds, 

b" 

0=1e T10000 30 

Exceed 

CONN-3076 Resolved an issue where remote application windows would appear 

on all Windows 10 virtual desktops, instead of on a single virtual 

desktop.  This issue occurred only when the following settings were 

used in Xconfig: 

Window Mode = Multiple 

Exceed 
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JIRA ID Description Affected 

Component(s) 

Window Manager = X 

CONN-3067 Resolved the following keyboard input issues: 

• When a user pressed the [ or ] keys (with or without using the 

Shift key) on the French or French Canadian keyboard, the 

keys did not produce any output. 

• When a user typed AltGr+'5', or AltGr+'-', using  

french.kbf, the correct keys appeared. This was not the 

case with the frencan.kbf, as they appeared as ¤ and ½, 

as shown on the physical keyboard.  

Exceed 

CONN-3054 Provided an updated humcssx.dll to address the following issue: 

• Customer connects to the host over VPN, using a predefined 

SSH tunnel, configured as follows: Use for 

Authentication. The  Xconfig > Security is set up for No 

host access.  

The following error message is shown:  

X connection to local host broken (explicit 

Kill or server shutdown). 

humcssx.dll 

CONN-3019 Resolved the following issue: 

• HostExplorer 15.0.2 Web Deployment installs only via Java, 

and not ActiveX, if an older Connectivity version was 

previously deployed to the desktop. A message was 

displayed, indicating that the Active X had timed out. 

Deployment 

Wizard 
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8.3 Issues resolved in Connectivity 15.0.2 hot fixes 

The following issues were resolved in hot fixes after the release of Connectivity 15.0.2, and prior to 

completion of Connectivity 15.0.3 release. All the hot fixes are cumulative and included in the 15.0.3 

release. 

Hot Fix 15 

CONN-3164 Resolved the following issue:  

• When the user right-clicked within an X application, 

the right-click menu was not displayed, as expected.  

The issue occurred because Exceed Version 15 did not 

provide a mechanism to define 3-button pointer devices. 

Exceed X server always reported 10-button mouse, even 

when the following relevant options were configured 

appropriately, as follows:  

ExtraButtonSupport=0  

Wheel Movement is ignored = ON   

Exceed 
 
exceed.exe 

 
 

Hot Fix 13 

CONN-3099 Resolved a keyboard input issue, observed with Exceed 15.0 

connecting to AIX 6. If Caps Locks key was enabled, the 

following keys did not work:  

• Backspace 

• Enter  

Exceed 
 
exceed.exe 

 
 

Hot Fix 12 

CONN-3154 Resolved an issue of a black image left on the menu bar,  
when  Robcad was run with Exceed 15.  

Exceed 
 
exceed.exe 

 
 

Hot Fix 11 

CONN-3126 Resolved the following issue:  HostExplorer 
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• Launching an FTP profile from Windows Explorer 

triggers a Runtime Error in Windows Explorer. 

Hot Fix 10 

 CONN-

3160 

OpenSSL files have been updated to  OpenSSL 1.0.2.j.  
 
Public Description:  

Major changes between OpenSSL 1.0.2i and OpenSSL 

1.0.2j [26 Sep 2016] 

• Missing CRL sanity check (CVE-2016-7052) 

Major changes between OpenSSL 1.0.2h and OpenSSL 

1.0.2i [22 Sep 2016: 

• OCSP Status Request extension unbounded 

memory growth (CVE-2016-6304) 

• SWEET32 Mitigation (CVE-2016-2183) 

• OOB write in MDC2_Update() (CVE-2016-6303) 

• Malformed SHA512 ticket DoS (CVE-2016-6302) 

• OOB write in BN_bn2dec() (CVE-2016-2182) 

• OOB read in TS_OBJ_print_bio() (CVE-2016-2180) 

• Pointer arithmetic undefined behaviour (CVE-2016-

2177) 

• Constant time flag not preserved in DSA signing 

(CVE-2016-2178) 

• DTLS buffered message DoS (CVE-2016-2179) 

• DTLS replay protection DoS (CVE-2016-2181) 

• Certificate message OOB reads (CVE-2016-6306) 

Connectivity 
 
Server OpenSSL binary and 
libraries   
 

Hot Fix 9 

CONN-3146 Resolved an issue of flickering graphics, observed with 

Motif/OpenGL applications and Exceed 15. 

Exceed 

Hot Fix 8 

CONN-3099 Resolved the following keyboard input issue:  

• When the Caps Lock was enabled the Backspace 

and Enter keys were not functional.  

Exceed 

https://www.openssl.org/news/vulnerabilities.html#2016-7052
https://www.openssl.org/news/vulnerabilities.html#2016-6304
https://www.openssl.org/news/vulnerabilities.html#2016-2183
https://www.openssl.org/news/vulnerabilities.html#2016-6303
https://www.openssl.org/news/vulnerabilities.html#2016-6302
https://www.openssl.org/news/vulnerabilities.html#2016-2182
https://www.openssl.org/news/vulnerabilities.html#2016-2180
https://www.openssl.org/news/vulnerabilities.html#2016-2177
https://www.openssl.org/news/vulnerabilities.html#2016-2177
https://www.openssl.org/news/vulnerabilities.html#2016-2178
https://www.openssl.org/news/vulnerabilities.html#2016-2179
https://www.openssl.org/news/vulnerabilities.html#2016-2181
https://www.openssl.org/news/vulnerabilities.html#2016-6306
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Now, if the user disables the XKEYBOARD extension, and 

then presses the Backspace and Enter keys, they work with 

the CapsLock key enabled. 

CONN-3128 Resolved a keyboard shortcut issue. The following key 

combination  did not have the expected result,  with Exceed 

15: 

Left_Ctrl + Left_Shift + 0     

Exceed 

Hot Fix 7 

CONN-3143 Resolved an issue of Feadms X application, where blue XYZ 

axis was displayed instead of red one.  

Exceed 

Hot Fix 6 

CONN-3138 Resolved an issue observed with Exceed and Product Data 

Manager (PDM) – PDM submenu froze and was 

unresponsive.  

Exceed 

Hot Fix 5 

CONN-3136 Resolved a font related issue. Custom WFF fonts were not 

shown correctly in Exceed 15 (they were either not displayed 

or were partially cut off).  

 

Exceed 

Hot Fix 4 

CONN-3056 OpenText Exceed XDK now supports MinGW. Previously, 

users of Exceed XDK could not build MinGW applications 

using the Exceed XDK environment.  

libX11m.a 

CONN-3070 Resolved an issue causing incorrect behavior of the Motif 2.0 

File Selection dialog box (the Filter field). When selections 

were made, the directory name in the field was appended. 

hclxm.dll  XmStatic.lib 
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CONN-3125 Resolved an issue causing incorrect behavior of the Motif 2.1 

File Selection dialog box (the Filter field). When selections 

were made, the directory name in the field was appended. 

HclXm21.dll   XmStatic.lib 

 

Hot Fix 3 

CONN-3131 Resolved an issue observed when Exceed.exe crashed while 

running with Product Data Manager (PDM).    

Exceed 

CONN-3095 Resolved an Xserver crash issue, which occurred when the 

main window was minimized in an XDK X11 application.   

Exceed 

CONN-3116 Resolved the following keyboard  issue: 

• The Caps Lock key did not work when the 

XKEYBOARD extension was turned off. Yet, if the 

XKEYBOARD extension was enabled in  Xconfig, 

under the X Protocol, and Exceed was restarted, the 

Caps Lock key functioned normally.  

The Caps Lock key now behaves correctly, regardless of the 

state of the XKEYBOARD extension (whether it is disabled or 

enabled).  

Exceed 
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9 Connectivity 15.0.2 (Service Pack 2) 

This section lists the new features, resolved issues, and known issues of OpenText Connectivity, 

Version 15.0.2, also known as Version 15.0, Service Pack 2.   

9.1 New features and enhancements in Connectivity 15.0.2 

This section lists the new features implemented in this service pack.  

9.1.1 New OpenSSL Version 

OpenSSL files have been updated from OpenSSL 1.0.1p to OpenSSL 1.0.2g.  

 Note: In Version 1.0.2g, OpenSSL has discontinued support for SSLv2.  

9.1.2 New user interface and configuration for TLS/SSL connections  

Changes were introduced to the Transport Layer Security (TLS) and Secure Socket Layer (SSL) 

profile settings and connections.    

 

New in  15.0.2 Details 

Global configuration 

changes 

Several encryption flags have been introduced, which provide greater control over 

which encryption protocols are used.  These flags are: 

• Use TLS Only 

• Enable SSLv2 Protocol 

• Use Highest TLS as Default 

These flags affect the following products / components: 

• HostExplorer                                 

• HostExplorer Print Services           

• HostExplorer FTP                            

User interface change • A new option, Highest TLS Version, replaces Highest TLS/SSL Version, in 

the SSL/TLS configuration screen. 
• Highest TLS Version no longer supports negotiation of SSLv3 protocol, 

and this is now the default security setting.  Connections to SSLv3 or 

SSLv2 hosts will now require manual selection of the appropriate SSL 

protocol. 

• SSL Version 2 has been removed from the list of available protocols.  A 

global configuration flag has been added, which allows SSL Version 2 to 

be selected and used. 
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New in  15.0.2 Details 

  

Example menu: 

 
9.1.2.1 Configuration flags to be set in the .ini files 

This section lists the security protocol settings that affect profile connections globally:  

TLS or SSL 

setting 

Description 

Use Highest 

TLS as Default 

Default: ON  

This flag determines the default protocol for encrypted communications. 

• ON: Highest TLS Version will be used as the default option for new and existing 

profiles 

• OFF: SSL Version 3 will be used as the default option for new and existing 

profiles 

Use TLS Only Default: OFF 

Restricts all connection profiles to use only TLS protocol. 

• ON: Only TLS protocols will be available as selectable options; existing profiles 

that specify SSL will use TLS instead. 

• OFF: TLS and SSL protocols will be available as selectable options. 

Enable SSLv2 

Protocol 

Default: OFF  

This flag controls whether SSL Version 2 is a supported protocol. 

• ON: SSL Version 2 will be available as a selectable option; profiles that specify 

SSL Version 2 will use SSLv2 protocol. 

OFF: SSL Version 2 will not be available as a selectable option; profiles that 

specify SSL Version 2 will use TLS instead.  
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9.1.2.2 Example configurations (features enabled or disabled) 

 Note: By default, the settings are not written into the global files. For HostExplorer, the Use 

TLS Only setting is configured through the Global Options dialog. When an option is modified, 

HostExplorer must be restarted. For PrintServices and HE FTP, they must be added manually 

to enable or disable the features.  

Modify this .ini 

configuration file   

Enable feature Disable feature 

  

HostExplorer\HostEx.ini 

[Use TLS Only]  

HDFUBValue=1 

 

[Use Highest TLS as Default] 

HDFUBValue=1 

 

[Enable SSLv2 Protocol] 

HDFUBValue =1 

[Use TLS Only]  

HDFUBValue=0 

 

[Use Highest TLS as Default] 

HDFUBValue=0 

 

[Enable SSLv2 Protocol] 

HDFUBValue =0 

PrintServices\pesrv.ini [System.Settings] 

Use TLS Only=On 

 

[System.Settings] 

Use Highest TLS as Default=On 

  

[System.Settings] 

Enable SSLv2 Protocol=On 

[System.Settings] 

Use TLS Only=Off 

 

[System.Settings] 

Use Highest TLS as Default=Off 

  

[System.Settings] 

Enable SSLv2 Protocol=Off 

FTP\heshell.ini [FTP Settings] 

Use TLS Only=1 

 

[FTP Settings] 

Use Highest TLS as Default=1 

 

[FTP Settings] 

Enable SSLv2 Protocol=1 

[FTP Settings] 

Use TLS Only=0 

 

[FTP Settings] 

Use Highest TLS as Default=0 

 

[FTP Settings] 

Enable SSLv2 Protocol=0 
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9.1.3 New security message when a connection is made to a TLS system 

The following generic message was modified (shown when a connection was made to a pure TLS 

system): 

Using SSL as security mechanism 

The new message shows the following information:  

Negotiating (the version selected in the SSL/TLS version option) as 

security mechanism. 

Examples: 

Negotiating Highest TLS Version as security mechanism.     

Negotiating SSL Version 3 as security mechanism 

Negotiating TLS Version 1.2 as security mechanism 

9.1.4 New default value for Host Access Control for enhanced security 

This release introduces a security enhancement to Exceed. By default, a security warning is displayed 

if a connection is attempted by an unauthorized host that is not included in the Xconfig Host Access 

Control List (xhost.txt).  

The following Xconfig default setting is used after installing Exceed:  

Host Access Control List = File (xhost.txt) 

Connection Warnings: 'Warn on Unauthorized Connections' = ON 

This setting does not affect upgrades but clean installations only. 
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If Version 15.0 is … Then… 

Already installed Manually change the existing Default.XCFG, through Xconfig so that it 

has the same Xhost settings. 

–or- 

Copy the patched version of Default.XCFG from the global user template 

folder to the local user folder.  This will reset all the settings  to the new 

OpenText default values 

Example of typical Global User Template folder: 

<ProgramFiles>\Hummingbird\Connectivity\15.00\Default 

User\Exceed 

Not installed Obtain the updated Default.XCFG by applying the 15.0.2 patch during the 

original installation of Exceed itself.    

 

Product affected: Exceed 

9.1.5 Ability to add the host name to the title bar of Exceed windows in MWM 

Exceed can be configured to include the host name in the title bar of the windows shown in Multiple 

Window mode. The following undocumented flag has been added:  

ShowHostnameInTitle=0 

When the default is changed and set to 1,  the title bar of windows in MWM shows the host name.  

Example: xterm@hostname 

Please note:  

• The host name appears in all the windows (xterm@hostname - xclock@hostname etc.).  

• If the user uses Telnet to access another host, the window title bar changes to reflect this. 

Product Affected: Exceed 

9.1.6 Ability to remove Full Screen toolbar from the screen 

In Exceed, the Full Screen toolbar  appears if the user has chosen the following context:  
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• Single Window Mode – Full Screen. 

Starting with Version 15.0.2, you may disable this toolbar, based on your user preference.  

To disable the Full Screen toolbar: 

• Use the following flag in Xconfig or the Registry, under …\Exceed\XServer key:  

DontShowFSToolbar = 1 

This flag removes the Full Screen toolbar if it is set as DWORD to 1.  

To switch the Full Screen mode to Single Window Mode mode, and back: 

• Press the F11 key. 

9.1.7 Ability to auto-generate numeric suffix for 3270 print sessions 

When the user selects Print to File, each new print job is now assigned a new file number, in 

sequential, ascending order.   

Example:  

• c:\My\FileName999.txt  

c:\My\Filename1000.txt  

c:\My\FileName1001.txt  

c:\My\FileName1002.txt  

c:\My\FileName1003.txt  

c:\My\FileName1003.txt 

To enable this behavior for 3270 sessions, the following setting was added under Printer Session 

Properties > Printer Destination > Write mode: 

• Auto-generate numeric suffix 

 

 Product affected: HostExplorer  
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9.1.8 New default for saving the HostExplorer Basic source file   

By default, if the user selects the Save As option, a HostExplorer Basic source file will be saved to the 

location where it has been opened originally.  

Note: A HostExplorer Basic source file is also referred to as an EBS document.  

Product affected: HostExplorer Basic 

9.1.9 Improved messaging for FIPS modules 

When the FIPS Fingerprint check fails, a more specific message is now shown, to help the user to 

detect the cause.  

Previously, only a generic 500 SSL failure message was shown. If OpenSSL modules failed to 

load or initialize, the following messages are now shown, depending on the configuration:  

500 Failed to load or initialize Security Layer FIPS modules. 

-or- 

500 Failed to load or initialize Security Layer modules. 

9.1.10 Ability to modify the path for 32 bit program files during installation 

To apply this functionality, the ALLOWBROWSE32 property must be set from the command line. 

To set the ALLOWBROWSE32 from the command line: 

1. Open the command line prompt (go to Start > All Programs > Accessories > Command 

Prompt. 

2. Type msiexec /i packageALLOWBROWSE32=transform list. 

3. Press ENTER.  

Where: 
• i stands for the install command 

• ALLOWBROWSE32 is a property that  specifies the transform (.mst) files to be applied 

to the package.   

• package is the name of the Windows Installer package file (.msi). 

 Products affected: Exceed x64, HE x64, SecureShell x64 products 
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9.2 Issues resolved in Connectivity 15.0.2 

JIRA ID Description Affected 

Component(s) 

CONN-3040 Resolved an issue where the minimum window size was incorrectly 

rendered (smaller than the X application minimum window size).  

XServer 

CONN-3024 Resolved an issue affecting the Exceed feature that allowed the 

window to snap to the edge of the screen. When the Exceed bar was 

snapped to one of the primary monitor borders and an Xapplication 

window snapped to it, moving the mouse over the two screens 

resulted in a position reset for the Xapplication window. 

The issue was observed on a dual monitor configuration (with Multiple 

Window Mode enabled). 

OpenText Exceed 

CONN-3022 Resolved an issue where the current working directory was changed 

to the Exceed folder and not reverted back to the original 

location resulting in failures to load local X clients. 

OpenText Exceed 

XDK 

CONN-2977 Resolved a problem where, when the user ran an Xapplication,   

Exceed was unexpectedly launched locally, even though the DISPLAY 

variable pointed to a remote machine.   

OpenText Exceed 

XDK 

CONN-2953 Resolved a problem with the system bell delays/echoes.  OpenText Exceed 

CONN-2948 Updated the SSL components in parity with the OpenSSL product 

release, 1.0.2g. 

OpenText 

Connectivity Suite 

CONN-2943 Resolved an issue where Exceed would freeze and the session would 

have to be terminated. The issue occurred when the following keys 

were pressed simultaneously in a GNOME Terminal screen while  the 

option HIGHLIGHT THE POINTER WHEN YOU PRESS CTRL was 

enabled:   

• CTRL+Other Keys (such as CTRL+PageUP)  

OpenText Exceed 
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JIRA ID Description Affected 

Component(s) 

CONN-2940 Resolved the inability to enter additional lines at the bottom of the 

screen, during data set modification. The issue was observed in Edit 

mode, and with the following screen size: 62x160. 

OpenText 

HostExplorer 

CONN-2915 Re-enabled this legacy Xstart keyboard shortcut:  

Run  (Ctrl-R) 

Thus, the following legacy keyboard sequences can be used to open 

and run Xstart profiles: 

Open (CTRL-O)  

Run  (Ctrl-R) 

OpenText Exceed 

CONN-2913 Resolved the following obsolete timestamp issue:  

• A user without administrator privileges added a HostExplorer 
profile to the Default User location and then issued the 
following command: 

HumSettings.exe UPDATELASTMODIFIED=ProfileMP 

As a result:  

▪ The timestamp in the PerUser Settings.ini file was not 

updated to reflect the action performed. 

▪ Humsettings.log file showed that the newer timestamp 

was supposed to be updated for ProfileMP but the value 

was not updated in the file. 

OpenText 

HostExplorer 

CONN-2903 Resolved an issue where the following error was shown intermittently 

(after which the software would shut down):  

HostExplorer for Win32 has stopped working 

This happened with HostExplorer in a two-monitor setup, with two 
sessions running.  

 

OpenText 

HostExplorer 
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JIRA ID Description Affected 

Component(s) 

CONN-2901 Resolved an issue with an FTP file transfer within HostExplorer. Files 

were sent to a subfolder on the  main frame, and this caused the 

following error message: 

System out of memmory 

The same transfer worked when the FTP profile was used to send 

files.  

OpenText 

HostExplorer 

CONN-2899 Resolved a memory leek issue with Display Manager 

(DispMgr.exe). 

OpenText Exceed 

CONN-2807 Resolved a deployment page issue, which required the use of a 64-bit 

ActiveX object in order to use HostExplorer. The following message 

was shown:  

This deployment page requires the use of a 64-bit 

ActiveX object in order to use HostExplorer. However 

this is a 32-bit version of Internet Explorer. 

Please try to load the 64-bit version of Internet 

Explorer. 

• Administrator can now create 64bit package as per the 
standard procedure.  

• Users can then launch the 64-bit version of HostExplorer 

from a deployment site, using 32bit Internet Explorer tabs 

without requiring the use of the Java applet. 

Note: ActiveX Object or Document types are not supported. An error 
message is shown in that case.   

 

OpenText HDW 

CONN-2786 Resolved an issue with incorrect behavior of the Backing Store 

setting. When using an X window manager with BackingStores set to 

Always, Exceed may not restore minimized windows correctly. 

 

OpenText Exceed 
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9.3 Known issues in Connectivity 15.0.2 

JIRA ID Known issue Description 

CONN-2891 Setup fails when Web-to-Host and 

Deployment Wizard Admin image 

is created from Connectivity 

15.0.1 (Build.027) DVD image 

The issue occurs because HDW .msp for version 15.0.1 

(SP1) is not automatically copied to the Installer folder of 

the Admin image.  

Solution: Manually copy HDW MSP SP1 to the Installer 

folder of the Admin image, and the setup.exe will run. 

CONN-3052 Local password encryption / 

decryption depends on being able 

to load the FIPS libraries. 

Affects: Exceed, HostExplorer 

After upgrading to Connectivity Version 15.0.2, users 

running HostExplorer FTP with FIPS mode enabled (or 

using the FIPS-Only install option) will find that their 

stored passwords are blank and must be re-entered. 

Solution: Save the password again.  Going forward the 

password should be saved properly. 

_____________________________________________ 

Affects: Exceed, HostExplorer, Windows 8 or later, 32-

bit 

Users launching Connection Central from the desktop 

may discover that HostExplorer FTP profiles with FIPS 

mode enabled (or using the FIPS-Only install option) will 

not save the password, and (starting in Version 15.0.1) 

may fail to connect with an OpenSSL library loading 

error.  

Solution: When using HostExplorer FTP, launch 

Connection Central from the Start menu, instead of the 

desktop. 
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10 Connectivity 15.0.1 (Service Pack 1) 

This section lists the new features, resolved issues, and known issues of OpenText Connectivity, 

Version 15.0.1, also known as Version 15.0, Service Pack 1.   

10.1 New features and enhancements in Connectivity 15.0.1 

This section lists the new features implemented in this service pack.  

10.1.1 New OpenSSL Version 

OpenSSL files have been updated from OpenSSL 1.0.1L to 1.0.1p.  

10.1.2 FIPS compliance update 

You can now limit installation of the OpenSSL files to the FIPS Only version.  

The FIPS validated modules have the following file names: 

• libeay32f.dll (32-bit) 

• libeay64f.dll (64-bit) 

 

• Note: If you select the FIPS only feature you will lose the ability to connect to a non-

FIPS server and HostExplorer FTP may not be available. 

10.1.2.1 Which products are affected?  

The following OpenText Connectivity products use an embedded FIPS 140-2 validated cryptographic 

module (certificate #1747): 

• OpenText Exceed 15 SP1 and later 

• OpenText HostExplorer 15 SP1 and later 

• OpenText Secure Shell 15 SP1 and later 

10.1.2.2 Installation changes 

This section describes how FIPS compliance update affects product installation.  

Note: The FIPS Only feature requires that Connectivity 15.0.0 be uninstalled and then re-installed 

from the Connectivity 15.0.1 DVD / ISO image. Upgrading to 15.0.1 using the.msi/.exe will not offer 

the FIPS Only feature.  
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To install FIPS only version, you need to uninstall a previous version of Connectivity and perform a 

clean installation of OpenText Connectivity 15.0.1. See Installing  FIPS Only version of Connectivity  

15.0.1 on page 7.  

Personal Installation:  

To ensure that FIPS Only version is used, i.e., that only FIPS validated modules of OpenSSL files are 

installed:  

• At the Setup Type screen, select the check box: 

Ensure only FIPS Validated Cryptography is used   

Silent installation:  

The FIPS Only feature has been added to the installer. Selecting this option during silent installations 

is the equivalent of configuring the following option in the Properties section of the OpenText Setup 

Configuration Wizard: 

• Security.UseFIPSOnly 

If the FIPS Only feature is selected, OpenText Connectivity will install only FIPS Validated OpenSSL 

libraries built by OpenText. Thus, all SSL and SSH connections will run in the FIPS mode, even if it 

has not been enabled at the profile level.  

If… Then… 

An application fails to load the FIPS module 

during a FIPS Only installation. 

The connection is blocked and a  standard 

message is displayed 

500 SSL Negotiation failed 

HostExplorer failed to connect using SSL The following generic message is shown: 

Could not establish SSL connection 

If Select user certificate is enabled for both 

HostExplorer and FTP sessions 

The following message is displayed: 

Unable to load OpenSSL libraries 
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10.1.3 Ability to hide the IP icon in the system tray   

The IP system tray icon is no longer mandatory and is hidden by default.  Users who wish to enable 

this functionality can do so using a configuration setting. 

10.2 Issues resolved in Connectivity 15.0.1 

The following issues were resolved in OpenText Connectivity 15.0.1 

JIRA ID Description Affected 

Component(s) 

CONN-

2708 

Resolved an issue with a Static Display ID not being shown, after 

the user logged in for the second time.  

In the Citrix published application mode, under certain 

configurations, Exceed Display Controller may not be contacted 

correctly because of a timing issue. As a result, Exceed Display 

Controller now always synchronizes the consumption status of 

display numbers with run-time information retrieved from the system 

before assigning a new display number.  

Exceed Display 

Controller  

CONN-

2718 

Resolved an issue with the window ID being incorrectly assigned to 

the Transient For window. This issue resulted in the ability to move 

the main window on top of the Transient For window (for example, a 

dialog box or secondary window). The issue occurs in Native 

Window Mode, in the following context:  

• If the TSF ID equals the Root Window ID, the main window 

may move on top of the Transient For window when you 

click on the main window or change the focus. 

Exceed 

onDemand 

Client 

ThinX Proxy 

CONN-

2736 

Resolved an issue where the use of the Pin button from the Full 

Screen toolbar could display the wrong state. 

Xserver 

CONN-

2753 

Resolved an issue with the positioning of the Full Screen toolbar on 

a dual monitor machine. The toolbar was shown at the bottom of the 

monitor, which was not its expected placement.  

The issue was encountered in the following context:  

1. On a dual-monitor machine, place the second monitor on top of 
the Primary monitor. Make sure that the Windows taskbar is not 
auto-hidden. 

XServer 
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JIRA ID Description Affected 

Component(s) 

2. In Xconfig, change to Single Window Mode (SWM), with Full 
Screen using the All monitors option.  

3. Run Exceed with this Xconfig. 
 

CONN-

2757 

Resolved a memory leak (crash) issue involving Genesis (local X 

application) and exceed.exe, run overnight. 

XServer 

CONN-

2778 

Resolved an issue with HostExplorer EHLLAPI when an application 

was run as a service. 

HostExplorer 

CONN-

2789 

Resolved a general deployment error with the HostExplorer 

Deployment Wizard. Previously, the following message was 

displayed to indicate this deployment error: 

General Deployment Error. We are unable to 

Continue to Deploy on this machine. 

The error no longer occurs.  

HostExplorer 

Deployment 

Wizard 

CONN-

2791 

Resolved an issue with the following setting from the Printer Session 

Properties: 

Unable to save Ignore host-defined characters per 

line setting (WCC)     

Previously, the setting could not be saved.  

HostExplorer 

CONN-

2792 

Resolved an issue that affected how lines of text were displayed on 

a printed report (they overlapped each other). The reports are now 

printed correctly.  

HostExplorer 

CONN-

2796 

FTP/HostExplorer Shell no longer fails gracefully when OpenSSL 

fails to load.  

Note: The FIPS module requires that the module be loaded at a 

specific address. However, in Windows 8, another module is already 

loaded at that address. In this case, the FIPS module  presents a 

HE FTP 
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JIRA ID Description Affected 

Component(s) 

message box indicating there was a problem loading the modules 

and then exits gracefully. 

CONN-

2829 

This hot fix provides the following Security updates for MIT 

Kerberos:  

CVE 2014-5355 

OpenText 

Exceed (x64) 

OpenText 

Secure Shell 

(x64) 

CONN-

2877 

To address a usability issue and communicate clearly that  

Connectivity negotiates the use of the highest available version of 

SSL/TLS  that the server supports, the following string was 

renamed:  

Previous: SSL Version 2/3 

Current: Highest TLS/SSL Version 

 

In addition, the related dialog box, has been renamed.   

Previous: Cipher Suite for SSL V2/3 

Current: Cipher Suites for Highest TLS/SSL Version 

The SSL/TLS Options are available in Connection Central. 

OpenSSL 

 

https://cve.mitre.org/cgi-bin/cvename.cgi?name=CVE-2014-5355
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10.3 Known issues in Connectivity 15.0.1 

There are no known issues to report in this service pack. 

10.4 Files delivered in Connectivity 15.0.1 

The following installation files are available for this Service Pack. 

10.4.1 Complete file 

The following executable files have been provided for this service pack installation: 

OpenTextConnectivity15_ServicePack1.exe or 

OpenTextConnectivity15x64_ServicePack1.exe  

10.4.2 Individual product installation files  

       Note:  The dates and versions of installation packages are not always the same as the 

dates and versions of the individual files installed by the packages. 

Product Package or File Name Version 

Exceed OpenTextExceed15_ServicePack1.exe \ .msp  (Windows) 

OpenTextExceed15x64_ServicePack1.exe \ .msp  (Windows 

x64) 

15.0.1.215 

HostExplorer OpenTextHostExplorer15_ServicePack1.exe \ .msp 

(Windows) 

 OpenTextHostExplorer15x64_ServicePack1.exe \ .msp 

(Windows x64) 

15.0.1.215 

Secure Shell 

OpenTextSecureShell15_ServicePack1.exe \ .msp 

(Windows) 

OpenTextSecureShell15x64_ServicePack1.exe \ .msp 

(Windows x64) 

15.0.1.215 

Web 

Deployment 

Wizard 

OpenTextWeb-to-

HostandDeploymentWizard15_ServicePack1.exe \ .msp 

(Windows) 

10.0.0.55 
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Product Package or File Name Version 

OpenTextWeb-to-

HostandDeploymentWizard15x64_ServicePack1.exe \ .msp 

(Windows x64) 

 

11 General notes 

This section provides general notes and/or description of workarounds related to the products 

included in the Connectivity releases.  

11.1 Choosing between OpenGL performance and network 

efficiency / 2D-drawing-on-3D correctness 

Exceed 15 changed the default behaviour for OpenGL applications to prefer network efficiency and 

2D-drawing-on-3D correctness over performance. 

By default, it copies the OpenGL window content to its internal 2D X server buffer at 60hz. This 

means no Expose event needs to be sent if the OpenGL window is obscured, giving a potential 

responsiveness improvement and network bandwidth savings. Also, if an application does X11 2D 

drawing over the OpenGL window, the results will be as expected. This comes at a performance cost 

to the local GPU and may impact raw FPS.  

Setting the following DWORD registry key to 0 disables this mirroring and makes Exceed 15 behave 

the same as Exceed 14:  

HKCU\Software\Hummingbird\Connectivity\15.00\Exceed\XServer\GlxRefreshMirro

rMode 
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12 Contact information 

OpenText Corporation 

275 Frank Tompa Drive 

Waterloo, Ontario 

Canada, N2L 0A1 

 

OpenText My Support: https://support.opentext.com 

For more information, visit www.opentext.com  
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